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In This Chapter

 

The following topics are covered in this chapter:

 

Topic See Page

 

About the Instrument 1-2

Before You Begin 1-2

Documentation 1-3

Safety 1-4
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About the Instrument

 

System Components

 

The ABI P

 

RISM

 

®

 

 3100 and 3100-Avant Genetic Analyzers are automated capillary 
electrophoresis systems that can separate, detect, and analyze fluorescent-labeled 
DNA fragments in one run.

The 3100 or 3100-Avant Genetic Analyzer system includes the following components:

 

�

 

ABI P

 

RISM

 

®

 

 3100 or 3100-Avant Genetic Analyzer 

 

�

 

Computer workstation with Microsoft

 

®

 

 Windows NT

 

®

 

 operating system

 

�

 

ABI P

 

RISM

 

®

 

 3100 or 3100-Avant Genetic Analyzer Data Collection software

 

�

 

ABI P

 

RISM

 

®

 

 DNA Sequencing Analysis or ABI P

 

RISM

 

®

 

 GeneScan

 

®

 

 Analysis 
software 

 

�

 

Capillary array 

 

�

 

Reagent consumables

 

Before You Begin

 

Important Safety
Information

 

Before using the instrument, read the safety information starting on page 1-4 and in 
the 

 

ABI P

 

RISM®

 

 3100 Genetic Analyzer Site Preparation and Safety Guide

 

 
(P/N 4315835).

 

Audience

 

This manual is written for principle investigators and laboratory staff who are planning 
to operate and maintain a 3100 or 3100-Avant Genetic Analyzer.

Before attempting the procedures in this manual, you should be familiar with the 
following topics:

 

�

 

Windows NT operating system

 

�

 

General techniques for handling DNA samples and preparing them for 
electrophoresis. Networking, which is needed if you want to integrate the 3100 or 
3100-Avant Genetic Analyzer into your existing laboratory data flow system
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Documentation

 

List of User
Documents

 

The following table lists the complete ABI P

 

RISM

 

®

 

 3100 and 3100-Avant Genetic 
Analyzer document set for users:

 

User Bulletins

 

User bulletins inform you of technical information, product improvements, and related 
new products and laboratory techniques.

Applied Biosystems will mail user bulletins related to the use of this instrument to you. 
We recommend storing the bulletins in this manual behind the tab labeled “User 
Bulletins.”

 

Title Contents P/N

 

Instrument 

 

ABI P

 

RISM

 

 3100 Genetic Analyzer 
and 3100-Avant Genetic Analyzer 
Site Preparation and Safety Guide

 

�

 

Laboratory requirements for 
installation

 

�

 

Instrument and chemical safety

4315835

 

ABI P

 

RISM

 

 3100 Genetic Analyzer 
and 3100-Avant Genetic Analyzer 
User Reference Guide

 

�

 

Theory of operations

 

�

 

System management

 

�

 

Troubleshooting

4335393

 

ABI P

 

RISM

 

 3100 Genetic Analyzer 
User Guide 

 

User procedures for using and 
maintaining the instrument

4334785

 

ABI P

 

RISM

 

 3100-Avant Genetic 
Analyzer User Guide 

 

User procedures for using and 
maintaining the instrument

4333549

Software

 

ABI P

 

RISM

 

 DNA Sequencing 
Analysis Software v. 3.7 NT User 
Guide

 

Detailed procedures for analyzing 
sequencing data 

4308924

 

ABI P

 

RISM

 

 GeneScan Analysis 
Software v. 3.7 NT User Guide

 

Detailed procedures for analyzing 
fragment analysis data 

4308923

Chemistry

 

ABI P

 

RISM

 

 3100 Genetic Analyzer 
Sequencing Chemistry Guide

 

�

 

Detailed chemistry procedures 
specific for the 3100 Genetic Analyzer

 

�

 

Chemistry troubleshooting for the 
3100 Genetic Analyzer

4315831

 

ABI P

 

RISM

 

 Automated DNA 
Sequencing Chemistry Guide

 

�

 

A description of DNA sequencing 
instruments, chemistries, and software

 

�

 

Detailed procedures for preparing 
DNA templates, performing cycle 
sequencing, and preparing extension 
products

4305080
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Safety

 

Documentation User
Attention Words

 

Five user attention words appear in the text of all Applied Biosystems user 
documentation. Each word implies a particular level of observation or action as 
described below.

 

Note

 

Calls attention to useful information.

 

IMPORTANT

 

Indicates information that is necessary for proper instrument operation, accurate 
chemistry kit use, or safe use of a chemical.

Indicates a potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury. It may also be used to alert against unsafe practices.

Indicates a potentially hazardous situation which, if not avoided, could result in 
death or serious injury.

Indicates an imminently hazardous situation which, if not avoided, will result in 
death or serious injury. This signal word is to be limited to the most extreme situations.

 

Chemical Hazard
Warning

 

CHEMICAL HAZARD

 

. Some of the chemicals used with Applied Biosystems 
instruments and protocols are potentially hazardous and can cause injury, illness, or death.

 

�

 

Read and understand the material safety data sheets (MSDSs) provided by the 
chemical manufacturer before you store, handle, or work with any chemicals or 
hazardous materials.

 

�

 

Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (

 

e.g.,

 

 safety glasses, gloves, or protective clothing). For 
additional safety guidelines, consult the MSDS.

 

�

 

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (

 

e.g.

 

, fume hood). For additional safety guidelines, 
consult the MSDS.

 

�

 

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the 
manufacturer’s cleanup procedures as recommended on the MSDS.

 

�

 

Comply with all local, state/provincial, or national laws and regulations related to 
chemical storage, handling, and disposal.

 

\
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Chemical Waste
Hazard Warning

 

CHEMICAL WASTE HAZARD

 

. Wastes produced by Applied Biosystems 
instruments are potentially hazardous and can cause injury, illness, or death.

 

�

 

Read and understand the material safety data sheets (MSDSs) provided by the 
manufacturers of the chemicals in the waste container before you store, handle, or 
dispose of chemical waste.

 

�

 

Handle chemical wastes in a fume hood.

 

�

 

Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (

 

e.g.,

 

 safety glasses, gloves, or protective clothing). For 
additional safety guidelines, consult the MSDS.

 

�

 

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (

 

e.g.

 

, fume hood). For additional safety guidelines, 
consult the MSDS.

 

�

 

After emptying the waste container, seal it with the cap provided.

 

�

 

Dispose of the contents of the waste tray and waste bottle in accordance with 
good laboratory practices and local, state/provincial, or national environmental 
and health regulations.

 

Site Preparation and
Safety Guide

 

A site preparation and safety guide is a separate document sent to all customers who 
have purchased an Applied Biosystems instrument. Refer to the guide written for your 
instrument for information on site preparation, instrument safety, chemical safety, and 
waste profiles.

 

About MSDSs

 

Some of the chemicals used with this instrument may be listed as hazardous by their 
manufacturer. When hazards exist, warnings are prominently displayed on the labels 
of all chemicals. 

Chemical manufacturers supply a current MSDS before or with shipments of 
hazardous chemicals to new customers and with the first shipment of a hazardous 
chemical after an MSDS update. MSDSs provide you with the safety information you 
need to store, handle, transport and dispose of the chemicals safely.

We strongly recommend that you replace the appropriate MSDS in your files each 
time you receive a new MSDS packaged with a hazardous chemical.

 

CHEMICAL HAZARD

 

. Be sure to familiarize yourself with the MSDSs before 
using reagents or solvents.
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Ordering MSDSs

 

You can order free additional copies of MSDSs for chemicals manufactured or 
distributed by Applied Biosystems using the contact information below.

For chemicals not manufactured or distributed by Applied Biosystems, call the 
chemical manufacturer.

 

Instrument Safety
Labels

 

Safety labels are located on the instrument. Each safety label has three parts:

 

�

 

A signal word panel, which implies a particular level of observation or action (

 

e.g., 
CAUTION or WARNING). If a safety label encompasses multiple hazards, the 
signal word corresponding to the greatest hazard is used.

� A message panel, which explains the hazard and any user action required.

� A safety alert symbol, which indicates a potential personal safety hazard. See the 
ABI PRISM® 3100 Genetic Analyzer and 3100-Avant Genetic Analyzer Site 
Preparation and Safety Guide for an explanation of all the safety alert symbols 
provided in several languages.

To order documents by automated telephone service:

1 From the U.S. or Canada, dial 1.800.487.6809.

2 Follow the voice instructions to order documents (for delivery by fax).

Note There is a limit of five documents per fax request.

To order documents by telephone:

In the U.S. Dial 1.800.345.5224, and press 1.

In Canada Dial 1.800.668.6913, and press 1 for English or 2 for French.

To obtain documents through the Applied Biosystems Web site: 

Step Action

1 Go to http://docs.appliedbiosystems.com/msdssearch.html

2 In the SEARCH field, type in the chemical name, part number, or other information 
that will appear in the MSDS and click SEARCH.

Note You may also select the language of your choice from the drop-down list.

3 When the Search Results page opens, find the document you want and click on it to 
open a PDF of the document.
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About Waste
Disposal

As the generator of potentially hazardous waste, it is your responsibility to perform the 
actions listed below.

� Characterize (by analysis if necessary) the waste generated by the particular 
applications, reagents, and substrates used in your laboratory.

� Ensure the health and safety of all personnel in your laboratory.

� Ensure that the instrument waste is stored, transferred, transported, and disposed 
of according to all local, state/provincial, or national regulations.

Note Radioactive or biohazardous materials may require special handling, and disposal 
limitations may apply.

Before Operating the
Instrument

Ensure that everyone involved with the operation of the instrument has:

� Received instruction in general safety practices for laboratories

� Received instruction in specific safety practices for the instrument

� Read and understood all related MSDSs

Avoid using this instrument in a manner not specified by Applied Biosystems. 
Although the instrument has been designed to protect the user, this protection can be impaired 
if the instrument is used improperly.

Computer
Workstation Safety

Correct ergonomic configuration of your computer workstation can prevent 
stress-producing effects such as fatigue, pain, and strain. Minimize or eliminate these 
effects on your body by designing your workstation to promote neutral or relaxed 
working positions.

MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD. These hazards 
are caused by potential risk factors that include, but are not limited to, repetitive motion, 
awkward posture, forceful exertion, holding static unhealthy positions, contact pressure, and 
other workstation environmental factors.

� Use equipment that comfortably supports the user in neutral working positions 
and maintains adequate accessibility to the keyboard, monitor, and mouse.

� Position keyboard, mouse, and monitor to promote relaxed body and head 
postures.

Electric Shock ELECTRICAL SHOCK HAZARD. To reduce the chance of electrical shock, do 
not remove covers that require tool access. No user serviceable parts are inside. Refer 
servicing to Applied Biosystems qualified service personnel.

Lifting/Moving PHYSICAL INJURY HAZARD. Do not attempt to lift the instrument or any 
other heavy objects unless you have received related training. Incorrect lifting can cause painful 
and sometimes permanent back injury. Use proper lifting techniques when lifting or moving the 
instrument. Two or three people are required to lift the instrument, depending upon instrument 
weight.

WARNING!

WARNING!
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In This Chapter The following topics are covered in this chapter:
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2-2 System Overview

What the Instrument Does

Types of Analysis The ABI PRISM®  3100 and 3100-Avant Genetic Analyzer perform two kinds of 
analysis:

DNA Analysis Purpose

Sequencing analysis � Separates a mixture of DNA fragments according to their 
lengths

� Provides a profile of the separation

� Determines the order of the four deoxyribonucleotide bases

Fragment analysis � Separates a mixture of DNA fragments according to their 
lengths

� Provides a profile of the separation

� Determines the length of each fragment (in basepairs)

� Estimates the relative concentration of each fragment in the 
sample
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How the Instrument Works

Typical Run The following table describes a typical run on the 3100 and 3100-Avant instrument:

Stage Description Diagram

1 Sample Preparation

During sample preparation, the DNA fragments in a sample are 
chemically labeled with fluorescent dyes.

The dyes facilitate the detection and identification of the DNA. 
Typically, each DNA molecule is labeled with one dye molecule, 
but up to five dyes can be used to label the DNA sample.

Both the type of fluorescent labeling and the sample 
composition vary with the sample preparation method used. 

Samples are prepared in 96- or 384-well plates.

2 Software Setup

The operator creates a plate record and specifies the sample 
type and run module in the 3100 or 3100-Avant Genetic 
Analyzer Data Collection software.

3 Beginning the Run

The operator places the plates on the instrument and starts the 
run.

The autosampler automatically moves the sample plate into 
position to be sampled by the capillaries.

4 Electrophoresis

Molecules from the samples are electrophoretically injected into 
thin, fused-silica capillaries that have been filled with polymer. 
Electrophoresis of all samples begins at the same time when a 
voltage is applied across all capillaries. 

The DNA fragments migrate towards the other end of the 
capillaries, with the shorter fragments moving faster than the 
longer fragments.

5 Excitation and Detection

As the fragments enter the detection cell, they move through the 
path of a an excitation beam. The excitation beam causes the 
dye on the fragments to fluoresce. 

The fluorescence is captured by an optical detection device.
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6 Data Collection

The CCD camera converts the fluorescence information into 
electronic information, which is then transferred to the computer 
workstation for processing by the 3100 and 3100-Avant Data 
Collection software.

7 Data Processing

After the data is processed, it is stored in the instrument 
database and displayed as an electropherogram. 

An electropherogram plots relative dye concentration (y-axis) 
against time (x-axis) for each of the dyes used to label the DNA 
fragments.

Each peak in the electropherogram represents a single 
fragment size.

8 Automatic Data Extraction and Data Analysis

The processed data is automatically extracted and analyzed. 

The positions and shapes of the electropherogram peaks are 
used to determine either the base sequence or fragment profile, 
depending on the type of run selected. 

The analyzed data is stored as sample files on the hard drive of 
the computer.

9  Viewing the Results

The analyzed data is viewed with either ABI PRISM® DNA 
Sequencing Analysis software (for sequencing) or ABI PRISM® 
GeneScan® Analysis software (for fragment analysis).

If necessary, the data is reanalyzed using different analysis 
parameters.

Stage Description Diagram
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Front View

Diagram and
Description

The following diagram shows the front of the instrument:

Table of Front View Components 

Part Function

Light switch Switches on and off the interior lights

On/Off button Switches on and off the instrument

Reset button Resets all of the electronics on the instrument including the 
firmware and the calibration file

IMPORTANT Use this button only as a last resort when the 
instrument is not responding. See the Maintenance section 
of the ABI PRISM® 3100 Genetic Analyzer User Guide or the 
ABI PRISM® 3100-Avant Genetic Analyzer User Guide for 
procedure.

Tray button Brings the autosampler to the forward position

Note This button works only when the instrument and 
oven doors are closed.

Reset button

Tray button

Status lights

Light switch

On/Off button

Doors
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Status lights

Table of Front View Components (continued)

Part Function

Indicates the status of the instrument as follows:

Light Appearance Instrument Status

All off Power off

Yellow solid Loading firmware

Yellow blinking � Loading calibration file

� Initializing subsystems

Green solid Ready for use

Green blinking Running

Red blinking Error
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Front View with Doors Open

Diagram and
Description

The following diagram shows inside the instrument’s doors:

Table of Instrument Components

Part Function

Anode buffer reservoir Contains 9 mL of 1X running buffer.

Buffer and water 
reservoirs (four)

Contains 16 mL of 1X running buffer or water.

Autosampler Holds the sample plates and reservoirs and moves to align the 
samples, water, or buffer with the capillaries.

Capillary array Enables the separation of the fluorescent-labeled DNA 
fragments by electrophoresis. It is a replaceable unit composed 
of 4 or 16 silica capillaries.

Detection cell Holds the capillaries in place for laser detection.

Lower polymer block Contains the anode electrode. The anode buffer reservoir 
connects to this block.

Oven Maintains uniform capillary array temperature.

Polymer-reserve syringe Contains and dispenses the polymer that fills the polymer 
blocks and the array-fill syringe. A 5-mL syringe.

Array-fill syringe Contains and dispenses the polymer under high pressure to fill 
the capillaries. A 250-µL syringe.

Upper polymer block Connects the two syringes and the detection end of the 
capillary array.

Detection cell 

Capillary array

Autosampler

Upper polymer 
block

Anode buffer reservoir

Array-fill syringe

Polymer-reserve syringe

Lower polymer block

Buffer and water
reservoirs

Oven
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Back View

Diagram and
Description

The following diagram shows the back of the instrument:

Table of Back View Components

Part Function

Air filter holder Holds the filter that cleans the air entering the instrument

Air inlet vents Allows air into instrument

IMPORTANT To ensure adequate air flow, do not place 
paper under the instrument.

Ethernet outlet Provides a network connection to the computer workstation

Chassis fan Pulls air out of the instrument

Laser fan Cools the laser

Power cord Supplies power to the instrument

Laser fan

Power cord

Ethernet outlet

Chassis fan

Air filter holder

Air inlet vents

Air inlet vents
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Computer Workstation

Overview The 3100 or 3100-Avant Genetic Analyzer is shipped with a computer workstation 
running the Microsoft® Windows NT® operating system. An optional color printer is 
available.

This manual is written with the assumption that you know how to use a computer 
workstation running the Windows NT operating system. If you are not familiar with this 
computer, refer to the Windows NT workstation documentation shipped with this 
system for specific operating information.

Function The computer workstation collects and analyzes data from the 3100 and 3100-Avant 
Genetic Analyzer.

System
Requirements

The following table lists the minimum requirements for the computer workstation:

Hard Drive
Partitions

During installation, the hard drives of your computer workstation were partitioned to 
create the following logical drives:

Item Minimum Requirements

Hard drive storage 2 drives, 9 GB each

Memory 256 MB RAM

Monitor 17-in. SVGA

Operating system Microsoft Windows NT v. 4.0 with Service Pack 5

Printer Optional

Processor Intel Pentium III 733 MHz

Physical Hard 
Drive Drive Function

1 C System operating files

D Reserved for the 3100/3100-Avant software and the 
analysis software

2 E Reserved for the instrument database
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Software

Overview The software installed on your computer workstation consists of:

� Data collection software that controls, monitors, and collects data from the 
instrument

� An analysis application that either analyzes raw sequencing data or sizes and 
quantifies DNA fragments

� Software that automatically extracts and analyzes the data

� A database

� Utilities that enable you to manage the files in the database

� A toolkit that enables you to develop customized applications

For a complete list of the software installed on your computer, see “Software 
CD-ROMs” on page 3-2.

Note Other programs are available from Applied Biosystems to align sequences, identify 
previously unsequenced regions, archive data, identify patterns of heredity, and perform other 
kinds of data manipulation. See your Applied Biosystems representative.

Note To avoid software conflicts, we recommend that you do not install third-party software 
onto the computer attached to the 3100 and 3100-Avant instrument. 
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Supported Dye Sets and Applications

Overview DNA fragments are detected and identified by the fluorescent dyes with which they are 
chemically labeled. Dyes are purchased and used as dye sets, which are optimized for 
particular applications.

3100 Dye Sets and
Applications

Use the table below to determine the correct dye set and matrix standard set for the 
application you are using.

Application or Kit Dye Set Matrix Standard Set

� ABI PRISM® BigDye® v3.0 Terminator chemistry

� ABI PRISM® BigDye® v3.0 Primer chemistry

Z BigDye® v3.0 Matrix 
Standards

BigDye® v3.0 Terminator 
Sequencing Standard

� ABI PRISM® BigDye® Terminator chemistry

� ABI PRISM® BigDye® Primer chemistry

� ABI PRISM® dRhodamine Terminator chemistry

E DS-01

Custom oligos D DS-30 

� ABI PRISM® Mouse Mapping Set v1.0

� Custom oligos

D  DS-31
(DS-30 + VIC™ Matrix 

Standard)a

a. Replace the HEX™ matrix standard in DS-30 kit with the VIC matrix standard.

� AmpFlSTR® COfiler® Kit

� AmpFlSTR® Profiler Plus™ Kit

� AmpFlSTR® SGM Plus® Kit

� Other 4-Dye AmpFlSTR® Kits

F DS-32

 ABI PRISM® SNaPshot™ Multiplex System E5 DS-02

� ABI PRISM® Linkage Mapping Set (LMS) v2.5

� Custom Oligos

� AmpFlSTR® Identifiler™ Kit

� Other 5-Dye AmpFlSTR® Kits

G5 DS-33
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3100-Avant Dye Sets
and Applications

Use the table below to determine the correct dye set and matrix standard set for the 
application you are using.

Polymers

Overview The ABI PRISM® 3100 POP Polymer™ is used as a replaceable sieving medium that 
separates the DNA fragments by size during electrophoresis.

POP polymer is shipped ready to use. 

Supported Polymers Two polymers used with the 3100 and 3100-Avant system are as follows:

Chemical Hazard CHEMICAL HAZARD. POP polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. Use for research and development purposes only.

Application or Kit Dye Set Matrix Standard Set

ABI PRISM® BigDye® Terminator v3.0 chemistry Z ABI PRISM® BigDye® 
v3.0 Matrix Standard

ABI PRISM® BigDye® 
v3.0 Terminator 

Sequencing Standard

ABI PRISM® BigDye® Terminator chemistry E DS-01

Custom oligos D DS-30 

� ABI PRISM® Mouse Mapping Set v1.0

� Custom oligos

D  DS-31
(DS-30 + VIC™ Matrix 

Standard)a

a. Replace the HEX™ matrix standard in DS-30 kit with the VIC matrix standard.

 ABI PRISM® SNaPshot™ Multiplex System E5 DS-02

� ABI PRISM® Linkage Mapping Set (LMS) v2.5

� Custom Oligos

G5 DS-33

Polymer Name Use for... Part Number

ABI PRISM® 3100 POP-4™ polymer Fragment analysis

Long read sequencing

Ultra rapid sequencing

4316355

ABI PRISM® 3100 POP-6™ polymer Standard sequencing

Rapid read sequencing

4316357
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Storage and
Expiration

POP polymers are stable on the instrument for 7 days.

Store any remaining ABI PRISM® 3100 POP™ polymer at 2 to 8 °C until the expiration 
date printed on the jar. 

Note Excessively hot environments may shorten the working life of the polymer.

Proper Disposal As the generator of potentially hazardous waste, it is your responsibility to perform the 
actions listed below:

� Characterize (by analysis if necessary) the waste generated by the particular 
applications, reagents, and substrates used in your laboratory.

� Ensure the health and safety of all personnel in your laboratory.

� Ensure that the instrument waste is stored, transferred, transported, and disposed 
of according to all local, state/provincial, or national regulations.

Note Radioactive or biohazardous materials may require special handling and disposal 
limitations may apply.

Injection Solution 

Overview The injection solution is a fluid that is used to:

� Denature (separate) the DNA strands.

� Resuspend DNA samples before starting a sample run. 

� Resuspend calibration standards during the preparation of a calibration or sample 
run.

� Maintain the electrical connection between the polymer in the capillaries and the 
injection wells in the electrophoresis chamber by acting as an electrolyte 
(necessary for electrophoresis).

Hi-Di Formamide The injection solution recommended for use with the 3100 and 3100-Avant is Hi-Di™ 
Formamide (P/N 4311320) or formamide of equivalent quality.

CHEMICAL HAZARD. Formamide is harmful if absorbed through the skin 
and may cause irritation to the eyes, skin, and respiratory tract. It may cause damage to the 
central nervous system and the male and female reproductive systems, and is a possible birth 
defect hazard. Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

WARNING!
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Capillary Array

Overview The capillary array is a replaceable unit composed of silica capillaries that, when filled 
with polymer, enable the separation of the fluorescent-labeled DNA fragments by 
electrophoresis.

Diagram

Description

Instrument Capillary Number in an Array

3100 16

3100-Avant 4

Capillary sleeve

Loading bar 

Capillary electrodes

Combs 

G
R

16
37

Detection cell

Part Function

Capillary sleeve Provides a seal, along with the ferrule and array ferrule knob, with 
the upper polymer block

Capillary electrodes Hold the capillary ends in position

Combs Separate the capillaries to maintain consistent positioning and heat 
distribution in the oven

Detection cell Holds the capillaries in place for laser excitation

Loading bar Supports the capillaries and provides a high-voltage connection to 
the capillary electrodes
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Available Lengths

Part Numbers For capillary array part numbers, see page B-1.

Electrophoresis

Overview Samples separate electrophoretically as they travel through the polymer in the 
capillary array. 

Temperature Housing the capillary array in a sealed oven controls electrophoresis temperature.

The following table lists the normal electrophoresis temperature for each type of run:

Length (cm) Use for...

22 Rapid fragment analysisa

a. Not supported for forensic applications.

IMPORTANT Fragment Analysis: For optimal resolution, as in the case of fine mapping, 
Applied Biosystems recommends using the 36-cm capillary array. However, the 22-cm capillary 
array can be used to rapidly scan the genome when using markers less than 360 bp. Refer to 
ABI PRISM® 3100 22-cm Capillary Array for High Throughput Microsatellite and SNP 
Genotyping User Bulletin for more information.

36 � Fragment analysis

� Ultra rapid DNA sequencing

� Rapid DNA sequencing

50 Standard DNA sequencing

80 Long read sequencing

Type of Run
 Temperature

(°C)

Standard DNA sequencing 50

Rapid DNA sequencing 55

Standard fragment analysis 60

Long read DNA sequencing 50

Ultra rapid DNA sequencing 55
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Electrophoresis Circuit

Overview A high-voltage electrical circuit facilitates the electrophoresis of DNA fragments. The 
electrical charge is conducted through the circuit by:

� DNA and ions in the polymer

� Ions in the buffer

� Electrons in the electrical wires and electrodes

Diagram The electrophoresis circuit is shown below.

Description During electrophoresis, a high voltage is applied between the loading bar (cathode) 
and the electrode located on the lower polymer block (anode). The voltage drives the 
movement of negatively charged DNA fragments through the polymer in the 
capillaries towards the anode. From the anode, the current flows back in electrical 
wires through the power supply to the cathode to complete the circuit.

ELECTRICAL SHOCK HAZARD. To reduce the chance of electrical shock, do 
not remove covers that require tool access. No user serviceable parts are inside. Refer 
servicing to Applied Biosystems qualified service personnel.

Capillaries containing polymer

Loading bar (cathode) (-)

Electrode (anode) (+)

Upper polymer block

Tubing
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Fluorescent Detection

Detection Overview The dye-labeled DNA fragments are separated by electrophoresis within the capillary 
array. Once the fragments enter the detection cell, they pass through a laser beam. 
The laser light excites the attached dye labels causing them to fluoresce.

The detection components work together to collect the fluorescence and convert the 
information into electronic form. The electronic information is then processed and 
displayed by the 3100 and 3100-Avant Data Collection software.

Detection
Components

The main components of the detection system and their function are listed in the 
following table.

Note The many lenses and mirrors integral to detection are not covered in this section.

Note More information on each of the components follows this section.

Laser

Overview When a dye-labeled DNA fragment moves into the path of the laser beam, some 
electrons in the dye are excited to higher energy levels as the laser light is absorbed. 
Shortly afterwards, the electrons return to their ground states and emit fluorescence 
light energy. The light emitted from each dye has a different spectral profile (color).

Laser Type The laser used to excite the dyes is an argon-ion laser.

Emission
Wavelengths

The primary emission lines are at 488 nm and 514.5 nm. 

Interlock For your safety, an interlock switch shutters the laser and shuts off the electrophoresis 
power supply if the doors of the instrument are opened.

For more information on laser safety, refer to the ABI PRISM® 3100 Genetic Analyzer 
and 3100-Avant Genetic Analyzer Site Preparation and Safety Guide (P/N 4315835).

LASER HAZARD. Exposure to direct or reflected laser light at 40 mW for 0.1 
seconds can burn the retina and leave permanent blind spots. Never look directly into the laser 
beam or allow a reflection of the beam to enter your eyes. 

Part Function

Laser Excites the attached dye labels as the DNA fragments pass 
through the detection cell

Spectral dispersion device Disperses the light by wavelength and a second set of 
lenses focuses the resulting light spectrum onto the CCD 
camera

CCD camera Converts the incident fluorescence into digital information 
that is processed by the 3100 and 3100-Avant Data 
Collection software
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Spectral Dispersion Device

Overview The spectral dispersion device is a grooved disk that spectrally separates the 
fluorescence emitted (light) from the dye-labeled DNA fragments. After the light is 
spectrally separated, it is focused onto the charge-coupled device (CCD) camera.

CCD Camera

Overview The CCD camera includes a rectangular silicon chip that converts the incident 
fluorescence light into digital information. 

This digital information (data) will be processed by the 3100 and 3100-Avant Data 
Collection software. 
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Software 3

In This Chapter The following topics are covered in this chapter:

Topic See Page

Software CD-ROMs 3-2

Software Suite 3-3

Applications in the Data Collection Software 3-5

Supporting Software 3-6

Types and Locations of Files 3-7

Edit Dye Display Information Dialog Box 3-8

Set Color Dialog Box 3-9

Manual Control Commands 3-11

Run Modules 3-13

Run Module Parameters 3-17

Transferring Run Modules Between Computers 3-18

Sequencing Analysis Modules 3-21

Creating a Sequencing Analysis Module 3-24

Analysis Modules for Fragment Analysis 3-30

Setting Up Sequence Collector Project Information 3-37

Preparing a Plate for Uploading to Sequence Collector 3-39

After Extracting to the Sequence Collector Database 3-44

3
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Software CD-ROMs

Introduction The ABI PRISM® 3100 and 3100-Avant Genetic Analyzer software was installed on 
your computer by an Applied Biosystems service engineer. 

Contents of the CDs This software is provided on a set of six CD-ROMs and their contents are listed below.

Determining the
Software Versions on

Your System

To determine the 3100 and 3100-Avant firmware and the 3100 and 3100-Avant Data 
Collection software versions installed on your system, click the About Data Collection 
button on the toolbar. 

Note Both the software and the instrument have to be running.

CD Title Contents

3100 or 3100-Avant Software � ABI PRISM® 3100 or 3100-Avant Firmware

� ABI PRISM® 3100 or 3100-Avant Data Collection 
software

� Auto Extractor

� Extractor utility

� Clean up database utility

� MethodImport utility

� Remove Run Modules utility

� Diskspace utility

� InitDB utility

� ABI Sample File Toolkit

� OrbixWeb™ v. 3.2 Professional Edition

� Orbix Desktop® v. 2.3 software

� Persistence Powertier® v. 4.321

� Java Runtime Environment® v.1.1.7b

� Adobe Acrobat Reader® with Search v. 3.01

GeneScan Applications
(optional)

ABI PRISM® GeneScan® Analysis software, including 
the GeneScan program and sizecaller

Sequencing Analysis Applications 
(optional)

ABI PRISM® DNA Sequencing Analysis software, 
including the Sequencing Analysis program, 
basecaller, and Factura™ Software

Oracle® Software Oracle® v. 8.0.5 database standard edition

Diagnostic software This software consists of diagnostic utilities for use by 
Applied Biosystems service engineers only.

PowerQuest Drive Image 5 
software

This software makes an image of the hard drive.
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Software Suite

Firmware Firmware controls the most basic operations of the instrument, such as turning on the 
laser. The firmware is largely controlled by the commands sent from the computer 
workstation. It acts as the link between the software commands and hardware 
operations.

The 3100 and 3100-Avant firmware resides on the computer workstation and is 
downloaded when the instrument is started. Therefore, the instrument and the 
computer workstation must be running to perform any functions.

Data Collection
Software

The 3100 and 3100-Avant Data Collection software performs the following functions:

� Works in conjunction with the firmware to control the mechanical operation of the 
instrument, such as moving the autosampler and switching on the oven

� Collects and stores plate record data in the instrument database

� Automatically schedules samples to particular runs

� Monitors and displays the status of the instrument, and saves it to the instrument 
database as EPT data

� Collects and converts fluorescence emission data to digital data during runs

� Stores the processed data in tables in the database and in temporary files on the 
hard drive

� Displays electropherograms for the current run or any previous run still stored in 
the instrument database

� Provides wizards, that guide you through routine maintenance procedures

� Provides utilities, that when launched, automatically perform database 
maintenance 

Additional
Information

Additional information about the 3100 and 3100-Avant software can be found in the 
readme files and release notes on the software CD-ROMs.



3-4 Software

File

Main Menus Submenus Submenus

3100/3100-Avant 
 Data Collection
software window
with tabs:
• Plate View
• Run View
• Status View
• Array View
• Capillary View

Service

Instrument

View

Tools

Verify Instrument

Send SCPI Command

Run Service Module

Help About Data Collection

Import Plate

Override Spatial Calibration

Override Spectral Calibration

Exit

Plate View

Run View

Status View

Array View

Capillary View

Instrument Status Monitor

Preferences

Sequence Collector Project Info

Data Collection

Data Analysis

Run

Skip to Next Run

Pause

Stop

Manual Control

Data Aquisition

Set Color

Display Run Data

Display EPT Data

Extract Data into Sample Files

Display Entire Run

Plate Editor

Module Editor

Change Polymer Wizard

Install Capillary Array Wizard

Autosampler Calibration Wizard

Perform Spatial Calibration

Display Spatial Calibration

Display Spectral Calibration

Set Active Spectral Calibration

Update Capillary Array Info

Data Collection
Software Menu

Flowchart
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Applications in the Data Collection Software

Auto Extractor/AE
Server

Auto Extractor is used to automatically extract and analyze the data after each run. 
The AE server is part of the Data Collection software and contains the Auto Extractor.

Diskspace Utility The Diskspace utility lists the amount of space that the database uses, the amount 
that is free for use, and the percent filled. 

Extractor Utility The extraction utility (Extractor) uses the run data in the instrument database to create 
sample files. If an ABIF sample file becomes corrupt or if you accidently delete a file 
that you want, you can use the Extractor utility to re-extract the data into the sample 
file. 

Directions for using the Extractor utility start on page 5-2.

Cleanup Database
Utility

The Cleanup Database utility (CleanupDB) deletes some of the information stored in 
the instrument database to make room for new run data.

Directions for using the Cleanup Database utility start on page 5-4.

Method Import
Utility

The Method Import utility (MethodImport) imports the data contained in method files 
into the instrument database. Use this utility to install new versions of methods sent 
out by Applied Biosystems after your genetic analyzer is installed. 

Directions for running the Method Import utility start on page 5-6.

Remove Run
Modules Utility

The Remove Run Modules utility (RemoveRunModules) removes all modules and 
associated information from the instrument database. Use this utility to quickly delete 
all old modules before importing new ones.

Directions for running the Remove Run Modules utility start on page 5-7.

Initialize Database
Utility

The Initialize Database utility (InitDB) completely erases and reinitializes the 
instrument database. Use this utility only when instructed to do so by an Applied 
Biosystems representative.

Directions for running the Initialize Database utility start on page 5-8.

ABI Sample File
Toolkit

Use ABI Sample File Toolkit to read ABIF sample files and to develop customized 
applications for the 3100 and 3100-Avant Genetic Analyzer.
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Supporting Software

OrbixWeb OrbixWeb v. 3.2 Professional Edition provides database management services 
between the 3100 or 3100-Avant Data Collection software, Extractor utility, and the 
Oracle database. OrbixWeb v. 3.2 Professional Edition has no user interface; however, 
it must always be running when the 3100 and 3100-Avant Data Collection software or 
Extractor utility is running.

Orbix Desktop Orbix Desktop v. 2.3 software is middleware that is used by the 3100 and 3100-Avant 
Data Collection software and the Extractor utility.

Persistence
Powertier

Persistence Powertier v. 4.321 is an application server that allows the 3100 and 
3100-Avant Data Collection software to interact with the instrument database.

Java Runtime
Environment

Java Runtime Environment v. 1.1.8 is software that enables the 3100 and 3100-Avant 
Data Collection software to run.

Adobe Acrobat
Reader

Adobe Acrobat Reader is a program that allows you to read electronic documents 
saved in the portable document format (PDF). 

Oracle Database The Oracle® instrument database stores the following types of information:

� Processed, but unanalyzed, fluorescence data, which is collected from the CCD

� Plate records, which contain information about plates and their samples

� Run schedules, which are lists of runs automatically assigned by the software

� Run modules 

� EPT data

This manual describes how the database is used by the 3100 or 3100-Avant software. 
Consult an Oracle database administrator for more information about administering 
the database. 

GeneScan Analysis
Software

If you purchased the GeneScan option, GeneScan Analysis software will be installed 
on the hard drive of your computer workstation. This software is used to:

� Review the fragment analysis profile and size data

� Reanalyze the data

DNA Sequencing
Analysis Software

If you purchased the sequencing option, DNA Sequencing Analysis software will be 
installed on the hard drive of your computer workstation. This software is used to:

� Review basecalled sequences

� Reanalyze the data
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Types and Locations of Files

Introduction The 3100 and 3100-Avant software includes many different files and folders. Some of 
these are created to store run data and calibration data. Others are required to run the 
software. 

IMPORTANT Never move or delete any file or folder unless specifically directed to do so by an 
Applied Biosystems representative or by the 3100 and 3100-Avant documentation. Doing this 
could render the software inoperable.

Filename Extensions You can recognize certain file types by the three-letter extensions in their file names. 
The common file types and their extensions for the 3100 system are listed below. 

Note The 3100-Avant system will show 3100-Avant instead of 3100 in the directory.

Extension File Type Directory (if Applicable)

.ab1 ABIF sample file for sequencing analysis D:\AppliedBio\3100\DataExtractor

.bat Batch file initiates a series of software 
events (e.g., 3100Collection.bat)

—

.bcp Basecaller parameter file D:\AppliedBio\Shared\Analysis\Basecaller\Params

.exe Executable program —

.fsa ABIF sample file for fragment analysis D:\AppliedBio\3100\DataExtractor

.fsf Factura settings file D:\AppliedBio\Shared\Analysis\Factura\Settings

.gsp Analysis module for GeneScan D:\AppliedBioi\Shared\Analysis\Sizecaller\Params

.ini Initialization file —

.log Log file in text file format —

.mcl Spectral calibration file D:\AppliedBio\3100\DataCollection\Spectral Cal 
Logs\Spectral Cal

.mob Mobility file D:\AppliedBio\Shared\Analysis\Basecaller\Mobility

.modexp Exported run module file —

.mtd Method file D:\AppliedBio\Support Files\Data Collection Support 
Files\Method Files

.par Spectral calibration parameter files D:\AppliedBio\Support Files\Data Collection Support 
Files\Calibration Data\Spectral Calibration\Param Files

.pdf Portable document format file that can be 
read by Adobe Acrobat Reader

—

.plt Plate file (tab-delimited text file) for import 
into the instrument database to create a 
plate record

D:\AppliedBio\Support Files\Data Collection Support 
Files\Plate Import Files

.saz Analysis module for sequencing analysis D:\AppliedBio\Shared\Analysis\Basecaller\Params

.scl Spatial calibration file D:\AppliedBio\3100\DataCollection\SpatialCalLogs

.scp Sizecaller parameter file D:\AppliedBioi\Shared\Analysis\Sizecaller\Params

.szs Size standard file D:\AppliedBio\Shared\Analysis\SizeCaller\SizeStandards

.tmp Temporary run or calibration data file written 
in code

—

.txt Text file that can be read by Notepad —



3-8 Software

Edit Dye Display Information Dialog Box

Introduction The formats for the dye colors shown in the electropherogram and capillary displays 
are set in the Edit Dye Display Information dialog box.

You can use the Edit Dye Display Information dialog box to:

� View the current settings for the displayed dye colors (e.g., the blue plots may 
represent the base cytosine)

� Hide the data for particular dyes so that it does not appear in the displays

� Change the names of the dye

� Change the color intensity

� Open the Set Color dialog box to change the colors shown. (See “Set Color Dialog 
Box” on page 3-9.)

Opening the Dialog
Box

Dialog Box
Operations

The operations of the Edit Dye Display Information dialog box are summarized in the 
diagram below.

To open the Edit Dye Display Information dialog box:

Step Action

1 Select Instrument > Data Acquisition.

2 Select Set Color.

This opens the Edit Dye Display Information dialog box as shown below.

 Click in the Name text box 
to change the name of the 
dye

Click to open the Set Color 
dialog box

Click to store any changes 
you make in the Set Color 
dialog box and close the 
Edit Dye Display 
Information dialog box

Click to test the effect of 
any changes you make, 
without storing the changes

Click to undo test 
changes 

Slide to 
increase/decrease 
the color intensity 

Clear to hide the 
data for this dye in 
the displays
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Set Color Dialog Box

Changing the
Display Colors Using

the RGB System

It is a good idea to change the colors used in the electropherogram and capillary 
displays if you find it hard to distinguish the default colors.

There are two ways to change the color used to represent the concentration of dye in 
the 3100 or 3100-Avant Data Collection software user interface:

� Using the red green blue (RGB) color system

� Using the hue saturation value (HSV) color system

The RGB system uses the three primary colors (red, green, and blue) in various 
proportions to create the other colors.

To change the displayed dye color using the RGB system:

Step Action

1 Select Instrument > Data Acquisition > Set Color.

2 a. Within the Edit Dye Display Information dialog box, click the Color box of the 
color you want to change. See “Dialog Box Operations” on page 3-8.

b. Select the RGB tab.

3 Move the sliders to mix the three colors until you produce the display color that you 
want.

4

5 Close the Edit Dye Display Information dialog box.

RGB tab

To... Click...

Incorporate the change OK

Ignore the change Cancel

Revert to the default colors Reset
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Changing the
Display Colors Using

the HSV System

The Hue Saturation Value (HSV) system describes colors in terms of three 
properties1:

Property Description

Hue The wavelength composition of the color, e.g., blue

Saturation (chroma) The purity of the color in a scale from gray to the most vivid version 
of the color

Value (intensity) The relative lightness or darkness of a color in a range from black 
to white; e.g., light red, dark green, etc.

1. See the Essential Guide to User Interface Design, W. O. Galitz (1996), John Wiley & Sons.

To change the displayed dye color using the HSV system:

Step Action

1 Select Instrument > Data Acquisition > Set Color.

2 a. Within the Edit Dye Display Information dialog box, click the Color box of the 
color you want to change. See “Dialog Box Operations” on page 3-8.

b. Select the HSV tab if it is not already selected.

3 Click in the circle and drag the cross-hair pointer around the circle to select the 
desired hue.

4 Click in the inner square and drag horizontally to select the desired saturation.

5 Click in the inner square and drag vertically to select the desired value.

6

7 Close the Edit Dye Display Information dialog box.

HSV tab
Hue

Value

Saturation 

To... Click...

Incorporate the change OK

Ignore the change Cancel

Revert to the default colors Reset
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Manual Control Commands

Table of Commands The following table displays the manual control options as they are organized in the 
Data Collection software.

Command Category Command Name Value

Electrophoresis Set Power Supply � On

� Off

Set Voltage A number between 0 and 15 kV

Laser Set State � Idle

� On

� Off

Set Power A number between 0 and 25 mW

Open/Close Shutter � Open

� Closed

Oven Set State � On

� Off

Set Temperature A number between 18 and 65 °C

Autosampler Move Forward N/A

Return N/A

Move Up/Down A number between –500 and 500 steps

Move to Site � Site 1 (left, front for 1X running 
buffer)

� Site 2 (left, rear for deionized water)

� Site 3 (right, front for deionized 
water)

� Site 4 (right, rear for deionized 
water)

Array-fill syringe Move Home N/A

Move Up A number between 1 and 1200 steps

Move Down A number between 1 and 1200 steps

Polymer-reserve 
syringe

Move Home N/A

Move Up A number between 1 and 1200 steps

Move Down A number between 1 and 1200 steps

Pin-valve Set Position � Open

� Closed

Capillary Fill � 50 cm/POP6

� 36 cm/POP4

� 36 cm/POP6

� 22 cm/POP4

� 80 cm/POP4
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Sending a Manual
Control Command

IMPORTANT The oven and instrument doors must be closed for manual control commands to 
execute.

Note You cannot send a manual control command during a run.

Note Some tasks require that you send more than one manual control command. For 
example, to heat the oven to 50 °C, you first send a command to turn on the oven, and then you 
send a command to set the temperature.

To send a manual control command: 

Step Action

1 Select Instrument > Manual Control. 

 

2 Select a Command Category from the drop-down list.

3 Select a Command Name. 

Note To check a command’s function, read the Comment box.

4 Enter or select a Value.

5 Click Send Command.
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Run Modules

Introduction The run module specifies the conditions for how the sample is run. Examples include:

� Duration of the run 

� Run temperature

� Injection time

Viewing a Run
Module

To view a run module: 

Step Action

1 Select Tools > Module Editor or click the Module Editor button on the toolbar.

This opens the Module Editor dialog box.

2 a. In the Modules group box, select either the Sequencing or GeneScan tab, as 
appropriate.

Note The Calibration tab lists the spatial and spectral calibration modules.

b. To view the parameters for a particular module, select the name of the module 
from the list. All the parameters for the run module are displayed.
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Creating a Run
Module

To create a new run module: 

Step Action

1 a. Click the Module Editor icon on the toolbar to open the Module Editor dialog box.

b. Click New.

2 a. Select the:

� Application

� Template module

� Name for the new module

b. Click OK.

3 Edit the parameter values that you want to change.

IMPORTANT Only whole numbers are accepted.

IMPORTANT Be sure that all values are red. Values in black are not saved.
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Editing a Run
Module

4 Click Save. 

Option: Click Save As. Enter a unique descriptive name and click OK.

Note Save cannot be applied to default run modules. Save the module under a 
different name.

5 When you are finished, click the Close button ( ) to exit the Module Editor.

To create a new run module: (continued)

Step Action

To edit an existing run module or to create a new run module: 

Step Action

1 a. Click the Module Editor icon on the toolbar to open the Module Editor dialog box.

b. Select a module by double-clicking.

2 Edit the parameter values that you want to change.

IMPORTANT Enter whole numbers.

IMPORTANT Be sure that all values are red. Values in black are not saved.
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3 Click Save As. 

Enter a unique descriptive name and click OK.

Note Save cannot be applied to default run modules. Save the module under a 
different name.

4 When you are finished, click the Close button ( ) to exit the Module Editor.

To edit an existing run module or to create a new run module: (continued)

Step Action
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Run Module Parameters
\

Introduction You can change the module parameters listed below when creating run modules. The 
parameters are listed in the table below in the order in which they appear in the run 
module editor.

Note Not all parameters are visible in the run module editor for all supplied sequencing, 
GeneScan run method files, and calibration files.

Modifiable Run
Module Parameters

The following table lists the user-modifiable run module parameters:

Parameter Comment

Run 
Temperature

The temperature of the oven during the run. The speed of electrophoretic 
migration decreases as the electrophoresis temperature decreases.

Cap 
FillVolume

The time set for the array-fill syringe to pump polymer into the capillaries. 

IMPORTANT If this value is decreased from that in the supplied run 
module, the polymer used during the previous run may not be completely 
replaced. This could lead to an accumulation of residual, large DNA 
fragments in the capillaries over time, causing an increase in background 
signal. 

Prerun Voltage The voltage applied across the capillaries during the prerun period of 
electrophoresis. A prerun is performed to equilibrate the ionic strength 
across the capillary array before electrokinetic injection.

Prerun Time The duration of the prerun period of electrophoresis.

Injection 
Voltage

The voltage applied across each capillary during electrokinetic injection. 
The injection voltage is directly proportional to the amount of DNA 
injected. This works in conjunction with the Injection Time to control the 
amount of DNA injected.

Injection Time The duration of electrokinetic injection. This works in conjunction with the 
Injection Voltage to control the amount of DNA injected.

Run Voltage The editable voltage applied across each capillary during a run. You may 
include a voltage ramp at the beginning of electrophoresis.

Data Delay 
Time

The period of electrophoresis between the completion of electrokinetic 
injection and the time at which the software starts to collect data.

Run Time The duration of electrophoresis, including the Data Delay Time. The 
maximum run time for DNA sequencing and fragment analysis runs is 
16,000 seconds.
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Transferring Run Modules Between Computers

Overview The process of transferring run modules between two instrument databases on 
different computers is illustrated below. 

Exporting a Module A run module cannot be transferred directly. The data in a run module must first be 
copied into a file that is created and stored on a hard drive. This is known as exporting 
the module because you are exporting it from the database. 

The file created has the file name format: filename.modexp

The hard drive to which the run module file is saved could be the local drive of the 
donor or acceptor computer, or it could be a server that is accessible to both 
computers. 
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Exporting a Run
Module

Importing a Module The data in the exported file is copied to the donor database to recreate the original 
run module. This is known as importing the module. The recreated run module has the 
same name as the original except for a unique number added by the software. The 
number is based on the date. This prevents conflicts with the original run module in 
the donor database.

Note You cannot read a run module file because it is written in code.

To export a run module: 

Step Action

1 Click the Module Editor icon on the toolbar to open the Module Editor dialog box.

2 a. Select the appropriate application (GeneScan, Sequencing, or Calibration) tab.

b. Select the module in the Modules group box that you want to export.

c. In the Modules group box, click Export. 

This opens the Export browse dialog box as shown for the 3100-Avant instrument 
below.

3 Navigate to the folder in which you want to save the run module file. 

Note Due to software limitations, you cannot select a folder on the desktop.

4 Double-click the destination folder so that its contents are displayed in the pane.

5 In the File name box, type a name for the file.

Note Keep the name to fewer than 32 characters. A file name longer than 32 
characters will not import.

6 Click OK. This creates a run module in the specified folder.

This message confirms 
a successful export.



3-20 Software

Importing a Run
Module File

Note A run module file name longer than 32 characters will not import. There is no error 
message.

To import a run module file:  

Step Action

1 Go to the computer to which you want to transfer the run module.

2 Click the Module Editor icon on the toolbar to open the Module Editor dialog box.

3 In the Modules group box, click Import. This opens a browser dialog box as shown 
for the 3100-Avant instrument below.

4 Navigate to the folder in which you saved the run module file and select the file.

Note Due to software limitations, you cannot select a folder on the desktop.

5 Click OK to import the file.

.

Your file shows up in the list. The Comments box confirms a successful import.



Software 3-21

Sequencing Analysis Modules

Introduction Sequencing analysis modules, created with DNA Sequencing Analysis software, 
provide the Auto Extractor with the parameters needed to analyze sequencing data. 

Some sequencing analysis modules are provided with the 3100 or 3100-Avant Data 
Collection software. In the DNA Sequencing Analysis software, the sequencing 
analysis module is called a sequencing analysis settings file.

Viewing and Editing
Analysis Modules for

DNA Sequencing

To view or edit a sequencing analysis module (.saz file): 

Step Action

1 Start the DNA Sequencing Analysis software. 

Note You may have an icon for the program on the Start menu. If not, you can find 
the DNA Sequencing Analysis software (SeqA.exe) in the following directory:

D:\AppliedBio\SeqAnal\Bin

2 Select File > Open > Seq. AZ Settings.
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3 Select the analysis module that you want to view or edit. 

The analysis modules are stored in the following directory:

D:\AppliedBio\Shared\Analysis\Basecaller\Params

This opens the sequencing analysis setting file (.saz).

To view or edit a sequencing analysis module (.saz file): (continued)

Step Action

3100 sequencing analysis 
modules

3100-Avant sequencing 
analysis modules



Software 3-23

4

You can edit the following settings:

� Basecaller Type can be Basecaller-3100 (for standard sequencing) or 
Basecaller-3100RR (for rapid-run sequencing). The files (.bcp) are located in the 
following directory:
D:\AppliedBio\Shared\Analysis\Basecaller\Params

� Basecaller Settings are specified in the Preferences dialog box (accessed from 
the Edit menu).

� If the Write .Seq Files box is selected, text files of the basecalled sequence are 
written in either ABI or FASTA formats.

� If a Factura Settings File is selected, Factura processing will be applied during 
analysis. 

– To view or edit a Factura settings file: Select File > Open > Factura Settings. 

– The files are located in the following directory:
D:\AppliedBio\Shared\Analysis\Factura

5

To view or edit a sequencing analysis module (.saz file): (continued)

Step Action

If you have made changes to 
the analysis module and 
you... Then...

want to save the changes click Save As to create a new analysis 
module. Enter a unique descriptive name and 
click OK.

don’t want to save the changes click the Close button to close the window.
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Creating a Sequencing Analysis Module
\

Overview Creating a sequencing analysis module requires:

� Creating a basecaller settings file

� Creating a Factura settings file

� Creating a new sequencing analysis module

� Saving the sequencing analysis module

For detailed information about the topics covered in this section, see the ABI PRISM® 
DNA Sequencing Analysis Software v. 3.7 NT User Guide (P/N 4308924).

Creating a
Basecaller Settings

File

To create a basecaller settings file: 

Step Action

1 Quit the 3100 or 3100-Avant Data Collection software if it is running.

2 Start the DNA Sequencing Analysis software. 

The Sample Manager window opens inside the Sequencing Analysis window.
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3 To set a cutoff condition for the analysis, select Edit > Preferences > Basecaller 
Settings. 

Note The default setting has the cutoff conditions disabled.

4 In the Preferences dialog box, click Create a set.

5 Check one or more of the Set endpoint check boxes as appropriate.

6 If you checked the second, third, or fourth check box, type the number(s) that you 
want to use into the text boxes.

The Create a set button becomes Save this set as.

Note “Ns” means bases that could not be assigned an identity.

7 Click Save this set as. 

a. Type a name for the basecaller settings file into the text box.

b. Click Save.

8 In the Preferences dialog box, click OK. 

This saves the basecaller settings.

To create a basecaller settings file: (continued)

Step Action
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Creating a New
Factura Settings File

To create a new Factura settings file:

Step Action

1 Select File > New > Factura Settings.

2 Select the required options, then click the Close button.

A Sequencing Analysis alert box displays.

3 Click Save.

The Save this document as dialog box displays.

4 In the File name box, type the name you want to use for the Factura settings file.

Note Do not use any of the following characters in the file name: *< > ? | / \ : ”. Do 
not use spaces.

5 Make sure that the file will be saved to the following directory:

D:\AppliedBio\Shared\Analysis\Factura\Settings
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Creating a New
Sequencing Analysis

Module

To create a new sequencing analysis module: 

Step Action

1 Select File > New > Seq.AZ Settings. 

2 From the Basecaller Type drop-down list, select a basecaller.

Either:

� Select the name of the basecaller settings file that you just created from the 
Basecaller Settings drop-down list, or

� Use the default settings

3 Select Write .Seq Files if you want a .Seq file created (this saves the sequence as a 
text file).

4 In the Sequence File Format group box, select either ABI or FASTA. 

Note Select FASTA only if you intend to export the data to a program that accepts 
FASTA files.

5
If you do... Then...

not want to use Factura 

software
leave Factura Settings File as Don’t Facturize.

want to use Factura software select a Factura settings file from the 
drop-down list.
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Saving the
Sequencing Analysis

Module

Note You can check that the analysis module was saved by examining a plate record in the 
plate editor as described below.

To save the newly created sequencing analysis module: 

Step Action

1 Click the Close button on the untitled dialog box.

2 Click Save. 

3

a. In the File name text box, type a name for the analysis module. 

Note Do not use any of the following characters in the file name: * < > ? | / \ : “. Do 
not uses spaces.

b. Make sure that the file will be saved to the following directory:
D:\AppliedBio\Shared\Analysis\Basecaller\Params

c. Click Save. 

This creates an analysis module with the format file name.saz.

3100-Avant 
analysis modules
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Ensuring the
Analysis Module

Was Saved

To check that the analysis module was saved: 

Step Action

1 Open the 3100 or 3100-Avant Data Collection software.

2 In the Plate View page, double-click a plate record to open the plate editor.

If the plate record is already open, close it, and then re-open it.

3 Scroll horizontally to the Analysis Module 1 column.

4 Click in a cell that lists a sequencing analysis module. The list of sequencing 
analysis modules drops down.

5 Make sure that the sequencing analysis module you just created is listed.

Note If it is not listed, you may have saved the sequencing analysis module in the 
wrong folder.
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Analysis Modules for Fragment Analysis

Introduction Analysis modules for fragment analysis provide the Auto Extractor with the 
parameters needed for analyzing data from fragment analysis.

Viewing and Editing
Analysis Modules

To view or edit an analysis module for fragment analysis (.gsp file): 

Step Action

1 Start the GeneScan Analysis software.

Note You may have a program icon for the GeneScan Analysis software on the 
Start menu or a shortcut icon on your desktop. If not, you can find the application 
(GeneScan.exe) in the following directory:

D:\AppliedBio\GeneScan\Bin

2 Select File > Open then select the Analysis Parameters icon.

3 Select the analysis module you want to view or edit. The analysis modules are 
stored in the following directory:

D:\AppliedBio\Shared\Analysis\Sizecaller\Params

4 Click Open. 
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5 If you want, you can make changes to the analysis module. For more information 
about the parameters, see the ABI PRISM® GeneScan® Analysis Software v. 3.7 NT 
User Guide (P/N 4308923).

6

To view or edit an analysis module for fragment analysis (.gsp file): (continued)

Step Action

If you have made changes to 
the analysis module and 
you... Then...

want to save the changes � Select File > Save As, assign a unique 
name, and then click OK, or

� Select File > Save to save the changes to 
the current analysis module.

IMPORTANT The analysis modules must be 
stored in the following folder:
D:\AppliedBio\Shared\Analysis\
Sizecaller\Params

do not want to save the 
changes

Click the Close button to close the window.



3-32 Software

Before Creating an
Analysis Module

Before creating an analysis module for fragment analysis, you may need to create a 
custom size standard file. 

You will need to create a custom file for performing:

� Denaturing runs but not using GeneScan™-350 Size Standard, 
GeneScan™-400HD Size Standard, or GeneScan™-500 Size Standard

� Non-denaturing runs using applications such as SSCP

� Runs using one of the Applied Biosystems internal lane standards, but 
significantly altering collection time or analysis range

� Runs where the size standard data differs significantly (i.e., extra or missing 
peaks)

Creating a Size
Standard File

To create a size standard file: 

Step Action

1 Review the size standard data and optimize the analysis parameters.

2 Quit the 3100 or 3100-Avant Data Collection software if it is running.

3 Start GeneScan Analysis software.

You may have a program icon for the GeneScan Analysis software on the Start 
menu or a shortcut icon on your desktop. If not, you can find the application 
(GeneScan.exe) in the following directory: 

D:\AppliedBio\GeneScan\Bin

4 Select File > New to open the Create New box.

5 a. Click the Size Standard icon to open a browser dialog box.

b. Navigate to the DataExtractor folder in the following directory:
D:\AppliedBio\3100\DataExtractor or 
D:\AppliedBio\3100-Avant\DataExtractor
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6 Select the GeneScan sample file (with the extension .fsa) that you want to use as a 
template.

7 a. Click Open. 

b. From the Dye drop-down list, select the dye-color that was used to label the size 
standard DNA fragments.

8 From the Analysis Parameters drop-down list, select <Analysis Parameters>. 

This references the current analysis parameter settings rather than an analysis 
parameter file.

To create a size standard file: (continued)

Step Action
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9 Click OK. 

10 In the Size column, enter the known sizes of the standard’s peaks.

11 Select File > Save. 

12 Navigate to the SizeStandards folder located in the following directory:

D:\AppliedBio\Shared\Analysis\SizeCaller\SizeStandards

The folder contains a number of size standard (.szs) files.

13 a. In the File name text box, type a file name for the size standard file.

b. Click Save. The browser dialog box closes and the file is saved to the correct 
directory location for Auto Extractor to read.

In the newly created Filename.szs dialog box, click the Close button.

To create a size standard file: (continued)

Step Action
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Creating an Analysis
Module for

Fragment Analysis

To create an analysis module for fragment analysis: 

Step Action

1 Select File > New. 

2 Click the Analysis Parameters icon. 

3 Fill out the untitled dialog box according to the directions given in the ABI PRISM® 
GeneScan Analysis Software v. 3.7 NT User Guide.

 

In the AutoAnalysis Only group box, select the size standard file that you just 
created from the Size Standard drop-down list.
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4 a. Select File > Save. 

This opens a browser dialog box.

b. Navigate to the Params folder in the following directory:
D:\AppliedBio\Shared\Analysis\Sizecaller\Params

5 a. In the File name text box, type a file name for the analysis parameter file.

b. Click Save. 

The browser dialog box closes and the file is saved to the correct directory location 
for the Auto Extractor to read.

6 In the newly created Filename.szs dialog box, click the Close button.

To create an analysis module for fragment analysis: (continued)

Step Action
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Setting Up Sequence Collector Project Information

Introduction In order to extract sample files into the Sequence Collector database, you must first 
set up information for your Sequence Collector project(s) in the 3100 or 3100-Avant 
Data Collection software. “Sequence Collector projects” are the Data Collection 
software equivalent of “collections” in Sequence Collector.

When samples are extracted into the Sequence Collector database, they are added to 
the specified Sequence Collector project.

Setting Up Sequence
Collector Project

Information

To set up the Sequence Collector project information: 

Step Action

1 Select View > Sequence Collector Project Info.

2

3 Enter the appropriate information in the text fields.

If you want to... Then...

add a new project a. Click Add Project and a blank row displays.

b. Continue with step 3.

delete an existing project a. Highlight the project you want to delete.

b. Click Delete Project.

c. Skip to step 4.

Text Field Description/Constraints

Project Name Type a descriptive name of your choice.

Note The Project Name will be the Collection Name in 
the Sequence Collector database.

Project Owner Type in your name.

Note The Project Owner will be the Creator in the 
Sequence Collector database.

Project Information Type in any comments, if desired.

Note The Project Information will be the Comment in 
the Sequence Collector database.
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4 Click OK to save your changes.

The new project(s) will be listed in the drop-down list under the Sequence Collector 
Project column in the Plate Editor window.

5 Continue with “Preparing a Plate for Uploading to Sequence Collector” on 
page 3-39.

To set up the Sequence Collector project information: (continued)

Step Action
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Preparing a Plate for Uploading to Sequence Collector

Introduction After you have set up the Sequence Collector project information, you must prepare a 
plate record in the 3100 or 3100-Avant Data Collection software for extraction to the 
Sequence Collector database. This requires:

� Specifying a Sequence Collector project in the plate’s sample sheet

� Setting Sequence Collector preferences for the plate

Specifying a
Sequence Collector

Project

To specify a Sequence Collector project in the plate’s sample sheet: 

Step Action

1 From the Tools menu, select Plate Editor.

2 Fill in the window items as follows:

Item Action

Plate Name Type the plate name. 

Application Click on the appropriate application.

Plate Type Choose the appropriate type from the drop-down list.

Comments Type comments if desired.
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3 Click Finish.

The Plate Editor spreadsheet opens with the plate name you assigned in step 2.

4 Fill in the spreadsheet, making sure to click on the Project Name column for each 
well and select a Sequence Collector project from the drop-down list.

IMPORTANT All plates must have a Project Name.

5 Click OK. 

Note You will receive a Please wait message before the software returns to the 
Data Collection software window.

6 a. If it is not already selected, select the Plate View tab.

b. Make sure your plate is listed under Pending Plate Records.

7 Highlight your plate and continue with “Setting Sequence Collector Preferences” on 
page 3-41.

To specify a Sequence Collector project in the plate’s sample sheet: (continued)

Step Action



Software 3-41

Setting Sequence
Collector

Preferences

To set Sequence Collector preferences for the plate: 

Step Action

1 Select View > Preferences.

2 In the Data Collection tab, set the following preferences:

a. In the Instrument Name field, enter a name for the instrument.

b. If you are importing plates from a database, then select the Enable plate import 
from database check box and enter a polling interval.
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3 Select the Data Analysis & Extraction tab.

Note When extracting to Sequence Collector the sample files are still created 
under D:\AppliedBio\3100\Data Extractor or D:\AppliedBio\ 3100-Avant\Data 
Extractor and they are uploaded to the Sequence Collector database.

4 a. In the Analysis and Extraction section, the Enable AutoAnalysis check box is 
selected as default. Clear the box if you do not want your samples autoanalyzed.

b. In the Data Extraction Folder Root section, use the default or click Browse to 
select a folder location for all generated data.

c. In Sample File Options, select how you want your sample files grouped. Select 
the By run button to group by individual run or select the By plate button to group 
by the entire plate.

d. In the Sample File Name Format section, use the drop-down lists to define the 
sample file name format. A prefix and/or suffix can be added as needed.

e. In the Run Folder Name Format section, use the drop-down lists to define the 
run folder name format. A prefix can be added as needed.

f. Click OK.

To set Sequence Collector preferences for the plate: (continued)

Step Action

If you are… Then…

generating sample files complete step 4 and skip step 6.

uploading data to Sequence 
Collector

proceed to step 5.
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5 For database files, define the following:

a. In the Analysis and Extraction section, select Extract to Sequence Collector.

The Enable AutoAnalysis check box is selected as default. Clear the box if you 
do not want your samples autoanalyzed.

b. In the Data Extraction Folder Root section, use the default or click Browse to 
select a folder location for all generated data.

c. In the Sequence Collector Login section, define the server, DB name, login, and 
password for the database you are using.

Note The server name is in the tnsnames.ora file and is the tnsalias name. This 
name is on the left-hand side of the = sign in the tnsnames.ora file.

d. In the Sequence Collector Naming Format section, use the drop-down lists to 
define the sample file name format. Add a prefix and/or suffix as needed.

6 Click OK. 

The preferences will be applied to your highlighted plate.

7 Continue your setup and run your samples as usual. 

When the run has completed, the sample files will be extracted to the Sequence 
Collector database automatically. 

Note View the xx_analysis.log or the xx_extraction .log file to see if the extraction 
completed successfully. 

Continue with “After Extracting to the Sequence Collector Database” on page 3-44.

To set Sequence Collector preferences for the plate: (continued)

Step Action
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After Extracting to the Sequence Collector Database

Introduction After your samples have run, you must view the run log file to ensure the extraction to 
the Sequence Collector database was successful.

IMPORTANT You will not receive any error messages if the extraction was not completed 
successfully (e.g., if the database connection was not established, if the Sequence Collector 
project information was entered incorrectly, etc.). The only way to check the status of the 
extraction is to view the xx_analysis.log or the xx_extraction.log file.

Viewing a Run’s Log
File

To view a run’s log file: 

Step Action

1 Open the directory that contains the 3100 or 3100-Avant Data Collection software 
and navigate to the ExtractedRuns folder. In most cases, the path will be either:

� D:\AppliedBio\3100\DataExtractor\ExtracedRuns 

� D:\AppliedBio\3100-Avant\DataExtractor\ExtracedRuns

2 Open the ExtractedRuns folder.

A directory is created in this folder for each run you’ve performed on the instrument.

3 Find the run for which you want to check the status and open its directory.

All the data collected and extracted for this run is stored in this directory.

4 Open either the xx_analysis.log or the xx_extraction.log to check:

If the extraction was... Then...

completed successfully The following message appears after each sample 
file listed “Successfully uploaded to Sequence 
Collector.”

not completed 
successfully

A message appears after each sample file listed, 
explaining why the extraction was not successfully 
completed. (For example “Failed to open connection 
with database using specified credentials or database 
was not alive.”)

You must manually upload the extracted data using 
Sample2DB. See the Applied Biosystems Sequence 
Collection Software Version 3.0 User's Guide, 
(P/N 4319527) for instructions.
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Working with Plate 
Records 4

In This Chapter The following topics are covered in this chapter:

Topic See Page

Creating Plate Records 4-2

Plate Record Fields 4-3

Tab-Delimited Text Files 4-7

Creating Tab-Delimited Text Files 4-8

Using Spreadsheets to Create Tab-Delimited Text Files 4-9

Spreadsheet or Tab-Delimited Text File Information 4-11

Running the Same Sample with Different Conditions 4-15

Creating a Plate Record by Importing LIMS Data 4-16

Plate Import Table 4-17

Creating a Plate File Using a Provided Template 4-19

Creating a Plate File from a New Spreadsheet 4-22

Creating a Plate File from a Custom Spreadsheet Template 4-23

Creating a Plate File from an Edited Plate Record 4-24

Importing Tab-Delimited Text Files and Linking Plate Records 4-25

Deleting Plate Records and Run Data 4-27

4
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Creating Plate Records

Introduction The instrument database stores information about the plates and the samples they 
contain as data tables named plate records. Each plate placed on the instrument 
requires a plate record.

Note A plate record is analogous to the Sample Sheet used with the ABI PRISM® 377 DNA 
Sequencer and an Injection List used with the ABI PRISM® 310 Genetic Analyzer.

When to Create
Plate Records

Create plate records in advance of placing the plates on the instrument or you can 
create a plate record while the instrument is running.

Data that will be imported for the creation of plate records can be prepared and stored 
on any networked computer or transferred from a computer on a disk.

How to Create Plate
Records

There are numerous methods used to create plate records. The most convenient 
method transfers data directly from a LIMS database. Once set up in the Preferences 
dialog box of the ABI PRISM® 3100 and 3100-Avant Data Collection software and the 
LIMS program, the transfer of data and creation of plate records is completely 
automatic, requiring no operator intervention.

Plate records can be created using the methods described in the following diagram:

For instructions for each method, see the pages listed in the following table:

Open the file as a
spreadsheet

Input the plate
and sample data

Modify the plate
and sample data

Plate record

Close the file,
saving changes
(as a tab delimited
text file)

In 3100/3100-Avant 
Data Collection  
software import the
filename.plt file

Save it as a
tab-delimited text file
using the
Export command

Modify the plate
and sample data

Save as a
tab-delimited text file
(filename.plt)

Save as a new
spreadsheet

Create a plate import
record in a LIMS
database.
Import automatically

Open the provided,
tab-delimited text file
template
(filename.plt) in
Microsoft® Excel

Open a spreadsheet
template created
by you in any
compatible spread-
sheet program

In 3100/3100-Avant 
Data Collection  software
use the plate editor to 
modify an existing plate
record

Make a new
spreadsheet in any
program

In 3100/3100-Avant 
Data Collection
software, input the plate
and sample data directly
into the plate editor

Method 2 Method 3 Method 4 Method 5 Method 6Method 1

Change the plate
name in Notepad

Method See Page... Method See Page...

1 4-16 4 4-22

2 ABI PRISM 3100 or 
3100-Avant User 

Guide

5 4-23

3 4-19 6 4-24
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Plate Record Fields

Introduction Plate record fields consist of the following:

� Dye sets

� Mobility files

� Size standards

� Run modules

� Analysis modules

� Sequence Collector 

Dye Sets Provided Select a dye set from among the following options:

Note See “Supported Dye Sets and Applications” on page 2-11 for more details on dyes.

IMPORTANT If you select the wrong dye set you will have to re-run your samples. You cannot 
correct this after the run because multicomponenting is applied during the run.

For... Select Dye Set

Fragment analysis D

Fragment analysis - SNP E5

Fragment analysis - Forensic applications F

Fragment analysis - high throughput LMS and HID applications G5

Fragment analysis - Molecular Diagnostic kits for the 3100 system only C

DNA sequencing analysis E

Z 
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About Mobility Files Note Mobility files are identical to the dye set/primer files used on other ABI PRISM genetic 
analyzers.

Mobility files are for DNA sequencing only. Mobility files are different for different dye 
sets and instrument types.

A mobility file contains the data that is used to compensate for differences in the 
electrophoretic mobilities of DNA fragments caused by labeling with different dye.

When a dye is bound to a DNA fragment, it changes the rate at which the fragment 
migrates during electrophoresis. Electrophoresing DNA fragments that are labeled 
with different dyes do not migrate with equal spacing because different dyes change 
the migration rate to different extents. Without correction, this would lead to an uneven 
separation of peaks in the electropherogram.

Mobility Files
Provided

The following mobility files are provided with the 3100 and 3100-Avant software and 
stored in the following directory and are described in the mobility file table: 

D:\AppliedBio\Shared\Analysis\Basecaller\Mobility

Note Select the newer version mobility file DT3100POP6{dRhod}v2.mob instead of the older 
version DT3100POP6{dRhod}v1.mob file.

Note New versions of mobility files may become available from the Applied Biosystems Web 
site. Mobility files for dye sets other than the ABI PRISM® BigDye® sets must be provided by the 
manufacturer.

Dye primer mobility files for 
3100 users only

dRhod v1.mob is an older 
version mobility file. See note 
below.
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Run Modules A module is a collection of routines that perform a task. Run modules define the run 
conditions for a sample. For a list of conditions you can set for running a sample, see 
“Modifiable Run Module Parameters” on page 3-17.

Run Modules Provided

The following run modules are provided with the 3100 and 3100-Avant software.

Analysis Modules A module is a collection of routines that perform a task. Analysis modules tell the 
AutoAnalyzer which parameters to use for data analysis. You can use the analysis 
modules provided and/or create your own to define different analysis parameters.

Analysis Modules Provided

The following analysis modules are provided with the 3100 and 3100-Avant software. 
You can examine the settings for each of the files using the analysis software. 

Sequencing modules GeneScan modules Calibration modules

Sequencing analysis modules Fragment analysis modules

3100 Analysis Modules
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Note Settings are described in the ABI PRISM® DNA Sequencing Analysis Software v. 3.7 NT 
User Guide and the ABI PRISM® GeneScan® Analysis Software v. 3.7 NT User Guide.

Analysis Module Run Type

DNA Sequencing

BC-3100POP4UR_SeqOffFtOff.saz Ultra rapid DNA sequencing

BC-3100POP4_80cm_SeqOffFtOff.saz Long read DNA sequencing

BC-3100POP6RR_SeqOffFtOff.saz Rapid DNA sequencing

BC-3100POP6SR_SeqOffFtOff.saz Standard DNA sequencing

Fragment Analysis

GS120Analysis.gsp GeneScan using size standard GS120

GS350Analysis.gsp GeneScan using size standard GS350

GS400HDAnalysis.gsp GeneScan using size standard 400HD

GS500Analysis.gsp GeneScan using size standard GS500

GS400CubicAnalysis.gspa

a. These modules are for advanced users with specific sizing needs. See the ABI PRISM® GeneScan® 
Analysis Software v. 3.7 NT User Guide.

—

GS400Ord2Analysis.gspa

Sequencing analysis modules Fragment analysis modules

3100-Avant Analysis Modules
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Tab-Delimited Text Files

Introduction Tab-delimited text files are text-only files that contain groups of information, called 
tokens, separated by tabs or end-of-line characters. Any text-only file (containing no 
graphics or tables) created in a word-processing program is a text file. Using tab stops 
to separate sections of text, and end-of-line characters to separate lines of text, makes 
a file a tab-delimited text file. 

Tab-delimited text files can be imported directly into the instrument database to create 
plate records.

Examples A tab-delimited text file created in Microsoft® Word is shown below. The symbols do 
not appear when the file is printed.

With the nonprinting symbols turned off, the file looks like this:

Word-Wrapped
Example

As in word-processed documents, tab-delimited text files with long lines wrap around 
to the next line. 

Word wrapping does not affect the performance of a file, but it does make the 
information more difficult to comprehend.

Notepad The Microsoft® Windows NT® operating system includes a simple text-only word 
processor called Notepad, located in the Accessories menu. Notepad will open any 
text-only file, even if the file was created by a program using the Macintosh® operating 
system. In this case, though, the end-of-line characters may need to be re-entered.
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Creating Tab-Delimited Text Files

Introduction Although it is possible to create tab-delimited text files by typing the required 
information directly into a word-processing program, it is easier to first enter the data 
into a spreadsheet, and then save the spreadsheet as a tab-delimited text file. 
Spreadsheets are easier to work with because they organize data clearly in columns, 
and because repetitive typing can be reduced by using their fill-down function.

You do not need to include all of the information required for a run before importing a 
tab-delimited text file into the instrument database. Information can be added to the 
plate record using the plate editor after the tab-delimited text file has been imported.

Note If you are importing data from a LIMS database, there cannot be any errors in the data 
because there is no opportunity to review it and the import will fail (see page 4-16).

Overview of the
Method

The typical method for importing information to create a plate record is outlined below. 
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Using Spreadsheets to Create Tab-Delimited Text Files

Introduction You can enter plate record data into any spreadsheet program that can save files as 
tab-delimited text files.

You can create spreadsheets in a program that uses the Macintosh operating system; 
however, you must then convert the files into Microsoft Windows format files. 
Examples are shown below.

Sequencing
Spreadsheet

An example of a spreadsheet, prepared in Microsoft® Excel, for samples intended for 
DNA sequencing is shown below.

For an explanation of the labels, see page 4-11.

Sequencing
Tab-Delimited Text

File

When the above spreadsheet is converted to a tab-delimited text file and opened with 
the Notepad program, it looks like the example below.

Fragment Analysis
Spreadsheet

An example of a Microsoft Excel spreadsheet for samples intended for fragment 
analysis is shown below.

Sample data

Column header

Plate header

Version number

Sample data

Column header

Plate header

Version number
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Fragment Analysis
Tab-Delimited Text

File

When the above spreadsheet is converted to a tab-delimited text file and opened with 
the Notepad program, it looks like the example below.

For an explanation of the labels, see page 4-11.

Empty Cells or
Tokens

Tab-delimited text files may be imported with empty tokens. Missing data can be 
added using the plate editor.

IMPORTANT A space character (entered by pressing the space bar) must be entered 
between tab stops in a tab-delimited text file, as a place marker for missing information. A space 
character must be entered into each blank cell of a spreadsheet before converting it to a 
tab-delimited text file.

IMPORTANT Do not leave whole empty rows (with the exception of the Well Location row) in a 
spreadsheet or tab-delimited text file that is intended for import, as illustrated by the example 
below.

Typing Accuracy
and Error Messages

It is extremely important to be accurate when typing information into a spreadsheet, 
tab-delimited text file, or LIMS database that will eventually be imported into the 3100 
or 3100-Avant Data Collection software.

When the 3100 or 3100-Avant Data Collection software is importing data from a text 
file, it compares the relevant tokens with lists of run modules, analysis modules, etc., 
stored in the database or hard drive. The Data Collection software recognizes the data 
only if it can make a match. If an “illegal” value is typed into a cell in certain columns, 
the typed data will be deleted and the field will be blank in the imported plate record. If 
the sample name contains restricted characters, the entire plate will not be imported.

IMPORTANT When naming the plate, you can use letters, numbers, and the following 
punctuation only: -_(){}#.+. Do not use spaces.

When importing data from a LIMS database, an error will be logged and no plate 
record will be created if the file contains a typing error.

Don’t do this:Do this:
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Spreadsheet or Tab-Delimited Text File Information

Introduction Four types of information are contained in a spreadsheet or tab-delimited text file 
intended for import into the 3100 and 3100-Avant Data Collection software:

� Version number

� Plate header

� Column header

� Sample data

See the spreadsheet examples in “Using Spreadsheets to Create Tab-Delimited Text 
Files” on page 4-9.

Version Number The version number is the only cell or token on the first row of a spreadsheet or 
tab-delimited text file. It specifies the version of the formatting conventions used for 
importing plate records. 

Currently, the version that must be entered into all spreadsheets is 1.0. If there are 
changes to the conventions, the version number will change, and you will be notified.

Plate Header The plate header is a sequence of five cells or tokens separated by tabs. These cells 
or tokens must always be typed in the same order across the plate header.

Cell or Token Function

Plate Name Identifies a specific plate. The plate name you assign must not exceed 
32 characters.

Note This is the same as the Plate ID listed in the plate record tables 
of the Plate View page.

Application Identifies a plate as containing samples for either GeneScan analysis 
(GS) or DNA sequencing (SQ).

IMPORTANT Do not mix samples for sequencing analysis and 
fragment analysis in the same plate.

Plate Type Defines the type of plate. The codes used for the two plate types are 
either:

� 96-Well

� 384-Well

Owner Identifies the name of the person who loaded the samples onto the plate 
and/or created the spreadsheet

Comment Allows you to enter comments about the plate
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Column Header for
Sequencing Analysis

The column header for sequencing analysis contains up to eight cells or tokens that 
provide headings for the columns that will contain the sample data. 

Column Headings

Column Head Function

Well Position Identifies the well in which the sample is located, e.g., A1, G6, O18, etc.

For 96-well plates, the well positions are A–H and 1–12. For 384-well 
plates, the well positions are A–P and 1–24.

IMPORTANT This cell or token must always be first (from left to right).

Sample Name Identifies the sample. The sample name you assign must not exceed 63 
characters. 

IMPORTANT When naming the sample, you can use letters, numbers, 
and the following punctuation only: -_(){}#.+. Do not use spaces.

IMPORTANT You must limit the sample name to 63 characters 
(59-character filename and 4-character extension). If you exceed 63 
characters, the name may be truncated when exported from the 3100 and 
3100-Avant Data Collection software.

IMPORTANT This cell or token must always be second (from left to 
right).

Dye Set Specifies the spectral information for the dyes used to label the DNA. This 
name must match the names stored in the instrument database.

Note If you select the wrong dye set you will have to re-run your 
samples. You cannot correct this problem after the run.

Mobility File Specifies the dye mobility file used for processing the fluorescence data.

Note This is identical to the dye set/primer file used with previous 
ABI PRISM® genetic analyzers.

Comment Allows you to enter comments about the sample.

Project Name Designates the Sequence Collector™ Genetic Information Management 
System Collection name into which this sample will be added.

Note Do not leave this cell blank.

Run Module Specifies the run module used for the sample.

IMPORTANT This cell or token must always be next to last (from left to 
right).

IMPORTANT The name of the run module must be typed correctly. If the 
name is typed incorrectly, the plate will be imported but the run module will 
not be entered in the plate record.

Analysis 
Module

Specifies the analysis module used to run the sample. Sequencing 
analysis modules have the file format: filename.saz

IMPORTANT This cell or token must always be last (from left to right).
You must always select an analysis module if you want the data to be 
extracted and analyzed.
The name of the analysis module must be typed correctly. If the name is 
typed incorrectly, the plate will be imported but the analysis module will not 
be entered in the plate record.
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Column Header for
Fragment Analysis

The column header for fragment analysis contains up to 10 cells or tokens that provide 
headings for the columns that will contain the sample data. 

Column Headings 

Cell or Token Function

Well Position Identifies the well in which the sample is located e.g., A1, G6, O18, etc.

For 96-well plates, the well positions are: A–H and 1–12. For 384-well 
plates, the well positions are A–P and 1–24.

IMPORTANT This cell or token must always be first (from left to right).

Sample Name Identifies the sample. The sample name you assign must not exceed 63 
characters. 

IMPORTANT When naming the sample, you can use letters, numbers, 
and the following punctuation only: -_(){}#.+. Do not use spaces.
You must limit the sample name to 63 characters (59-character filename 
and 4-character extension). If you exceed 63 characters, the name may 
be truncated when exported from the 3100 and 3100-Avant Data 
Collection software.

IMPORTANT This cell or token must always be second (from left to 
right).

Color Number Corresponds to a specific color button of the plate record Dye field.

Standard Dye Represents the size-standard color. This should be the number 4 for all 
4-dye applications, which corresponds to the red dye. Selecting the 
number 4 in this field is equivalent to selecting the diamond in the “R” 
color box of the GeneScan Analysis software. 

Use the number 5 for all 5-dye applications. 

Dye Set Specifies the spectral information for the dyes used to label the samples. 
It must match the names stored in the instrument database.

Color Info Enables you to identify the sample in GeneScan analysis software when 
you are examining samples by color if you enter the sample name in this 
optional field.

Color Comment (Optional) Enables you to customize the output for downstream analysis. 

Project Name Designates the Sequence Collector™ Genetic Information Management 
System Collection name into which this sample will be added.

Note Do not leave this cell blank.

Color Number Color Button

1 B

2 G

3 Y

4 R

5 O
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Sample Data The sample data begins on row 4 of a spreadsheet. A 96-well plate for sequencing 
analysis contains up to 96 rows of sample data (one row for each sample, and 
therefore each well). A 96-well plate for fragment analysis contains a multiple of 96 
rows, since one well can contain several dye channels, each labeled with a differently 
colored dye.

Run Module Specifies the run module used for the sample.

IMPORTANT This cell or token must always be next to last (from left to 
right).

IMPORTANT The name of the run module must be typed correctly. If 
the name is typed incorrectly, the plate will be imported but the run 
module will not be entered in the plate record.

Analysis Module Specifies the analysis module used to run the sample. Fragment 
analysis modules have the file format: file name.gsp

IMPORTANT This cell or token must always be last (from left to right).

IMPORTANT You must always select an analysis module if you want 
the data to be extracted and analyzed.
The name of the analysis module must be typed correctly. If the name is 
typed incorrectly, the plate will be imported but the analysis module will 
not be entered in the plate record.

Column Headings (continued)

Cell or Token Function
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Running the Same Sample with Different Conditions

Sample Run Options You can run the same sample up to five times using different combinations of analysis 
modules and run modules as follows:

� Same run module, but different analysis module

� Same analysis module, but different run module

� Different run module and analysis module

� Same run module and analysis module (replicate run)

Note Make sure that you have enough sample for the number of runs you specify.

Setting Up Multiple
Runs

Multiple runs of the same sample are set up in the plate record or tab-delimited text 
files imported to create a plate record. To perform more than one run with the same 
sample, add additional pairs of run modules and analysis modules to the tab-delimited 
text file as shown in the examples below.

Example One: A Sample Running with More Than One Run Module

Below is part of a spreadsheet showing data for a sample that will be run with three 
different run modules with the same analysis module:

� The Run Module and Analysis Module column headings are used only once. 

� Run modules and analysis modules are grouped in pairs with the run module 
always placed to the left of its paired analysis module.

Example Two: A Sample Running with More Than One Analysis Module

Below is part of a spreadsheet showing data for a sample that will be run with three 
different analysis modules, but with the same run module:

� The Run Module and Analysis Module column headings are used only once.

� Run modules and analysis modules are grouped in pairs, with the run module 
always placed to the left of its paired analysis module.
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Creating a Plate Record by Importing LIMS Data

Introduction This section provides an overview of transferring data from a laboratory information 
management system (LIMS) to the plate import table and a description of the format in 
which the LIMS data must be written. 

This section does not describe the detailed procedure, which is beyond the scope of 
this manual. 

Note To import LIMS data, you must know how to import binary data BLOBS into an Oracle® 
database.

Advantages of
Importing Data from

a LIMS Database

Data transferred from a LIMS database creates plate records that are identical to plate 
records created from tab-delimited text files. 

The advantages of using a LIMS database over tab-delimited text files are:

� The sample data is already entered into a LIMS database. Therefore, the data can 
be assembled quickly into the format required for import.

� Transferring data from a LIMS database is completely automatic. 

Automatic Data
Transfer

The data transfer process is automatic, it does not need to be initiated by a manual 
import command in the Data Collection software. 

When the software is configured to import LIMS data, it:

� Periodically polls the plate import table (described below) for new data transferred 
into it by the LIMS database

� Automatically: 

– Creates plate records from the transferred data

– Enters an event describing the import in the Events log

– Registers the plate record in the Pending Plate Record table of the Plate View 
page

Configuring the
Data Collection

Software for LIMS
Import

To use the automatic LIMS data-transfer feature, the 3100 and 3100-Avant Data 
Collection software must be configured to automatically poll the instrument database 
for plate import table entries. 

Sequence Collector is a type of LIMS database. For information about Sequence 
Collector, see page 3-37.
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Plate Import Table 

Introduction The instrument database contains a plate import table. It is the only part of the 
database that can be safely accessed by outside programs, as there are no links to 
other tables in the database.

Plate Import Table
Capacity

The number of sets of plate data that can be accommodated in the plate import table 
is dependent on the amount of available space in the instrument database. Once the 
data in the table has been successfully imported into the main database, the data is 
stored as a plate record. As a result, there is little need to keep the imported data in 
the plate import table once the success of the import has been verified. 
Applied Biosystems recommends that you periodically delete data from the plate 
import table. It is best to do this when the 3100 and 3100-Avant Data Collection 
software is not running. To delete data from the plate import table, consult your Oracle 
database administrator.

Errors If an error occurs while importing data from the plate import table, the error is 
registered in the following locations:

� Errors pane on the Status View page

� Run log table on the Run Log page

� Plate import table (status will be set to “Bad”)

Required Fields A LIMS entry into the plate import table must contain the following five fields:

Plate ID The plate ID is a unique identifier or primary key for the plate. This ID should not be 
the same as the plate name. The instrument database will not allow entry of a plate ID 
if that value is already used by another row in the plate import table.

Name The name is the name of the plate. This name should not be the same as the plate ID. 
The name is not a unique identifier for the plate in the plate import table and can be 
used more than once within the plate import table. However, once the data is used to 
create a plate record, the name becomes the database plate ID and must be unique 
among all existing plates.

Having the name field in addition to the plate ID field allows you to delete a plate 
record from the plate import table and then re-import it with the same name (but a 
different Plate ID).

Field Format

Plate ID Up to 32 characters

Name Up to 32 characters

Status Up to 32 characters

Plate BLOB BLOB

Plate BLOB version Integer
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The name must also be the same as the plate name given to the header in the BLOB 
equivalent of the tab-delimited text file. It can be up to 32 characters and must not 
contain any restricted characters.

IMPORTANT Use only the following characters, which are a subset of the characters allowed 
by the Windows NT operating system: letters, numbers, and -_(){}#.+

Status There are three status options:

The status of any data set stored in the plate import table can be checked at any time 
through the LIMS software.

Plate BLOB
Definition

The plate BLOB is an array of binary data that is equivalent (except in language) to a 
tab-delimited text file used for data import. The plate BLOB is written from a table in 
the LIMS database that contains data and formatting equivalent to a tab-delimited text 
file or spreadsheet used for data import. 

The plate ID in the header of the binary BLOB must exactly match the plate name in 
the plate import table.

Converting the data into a plate BLOB format requires a knowledge of SQL and is a 
topic beyond the scope of this manual. 

Plate BLOB Version
Number

The plate BLOB takes its version number from the header of the table used to create 
the plate BLOB. 

This number is 1.0 for the current release of the software, which is identical to the 
version in the tab-delimited text files prepared for import into the instrument database.

Status Assigned when... Set by...

New the data is ready for transfer LIMS

Old a plate table has been successfully imported 3100 or 3100-Avant Data 
Collection software

Bad the transfer was unsuccessful 3100 or 3100-Avant Data 
Collection software
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Creating a Plate File Using a Provided Template

Locating the
Templates

This method uses a tab-delimited text file template and Microsoft Excel to create a 
plate file. Templates are provided with the 3100 and 3100-Avant software and are 
listed below (See “Template File Names”). In Microsoft Excel, you are able to view a 
tab-delimited text file template in a spreadsheet format without saving it as a 
spreadsheet.

A plate file is a tab-delimited text file saved with the file name extension .plt. 

The templates provided with the 3100 and 3100-Avant Data Collection software are 
located in the following directory:

D:\AppliedBio\Support Files\Data Collection Support Files\Plate Import Files

Template File Names The templates provided with the 3100 and 3100-Avant Data Collection software are 
listed in the table.

Creating a Plate
Record Using a

Template

Template File Name Type of Template

FullPlate_GSWell_384.plt 384-well for fragment analysis

FullPlate_GSWell_96.plt 96-well for fragment analysis

FullPlate_SeqWell_384.plt 384-well for sequencing analysis

FullPlate_SeqWell_96.plt 96-well for sequencing analysis

To create a plate record using a template: 

Step Action

1 Launch Microsoft Excel.



4-20 Working with Plate Records

2  Select File > Open. 

3 Navigate to the Plate Import Files folder in the following directory:

D:\AppliedBio\Support Files\Data Collection Support Files\Plate Import Files

Notice that no files are displayed. This is because there are no Microsoft Excel files 
in this folder.

4 In the Files of type list box, select All Files.

5 Select the plate file (.plt file) template you want to use and click Open. 

The Text Import Wizard dialog box opens.

6 Click Finish. 

The file is displayed as a spreadsheet.

To create a plate record using a template: (continued)

Step Action
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7 Modify any data in the cells by clicking the cell and retyping. 

To save time, use the Fill Down command:

� Select the cell containing the information that you want to copy.

� From the Edit menu, select Copy.

� Drag the fill-down handle in the bottom-right corner of the cell to copy the 
information into adjacent cells.

8 Click the Close button.

Either a standard Windows NT message box or an equivalent Office Assistant 
message box is displayed.

9 Click Yes. 

This opens the Save As dialog box.

10 a. In the File name drop-down list, delete the name of the file that you selected and 
type a new name for the edited file. Make sure that you add the .plt extension.

b. Click Save. This saves the edited file as a new file.

11 Follow the directions starting on page 4-25 for importing a tab-delimited text file to 
create a plate record.

To create a plate record using a template: (continued)

Step Action
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Creating a Plate File from a New Spreadsheet

Creating a Plate File
from a New
Spreadsheet

To create a plate file (.plt file) from a new spreadsheet:

Step Action

1 On a computer using a Windows NT operating system, open a new spreadsheet file 
in a program that allows you to save a spreadsheet as a tab-delimited file.

2 Using the spreadsheet examples and the information about each token starting on 
page 4-11, type your information into the file. 

3 Select File > Save As.

In most spreadsheet programs, the Save As dialog box will open.

4 Type in a name for the tab-delimited file that you are about to create.

IMPORTANT Use only the following characters, which are a subset of the 
characters allowed by the Windows NT operating system: letters, numbers, and 
-_(){}#.+. Do not use spaces.

5 a. Save the file with the following file name format:
filename.plt. 

b. In the File Type text box (or equivalent), select the text file (tab delimited) file 
type or equivalent.

Note If you close Microsoft Excel before performing this step, the Office Assistant 
opens. Click Yes, and then Save.

6 Follow the directions starting on page 4-25 for importing a tab-delimited text file to 
create a plate record.
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Creating a Plate File from a Custom Spreadsheet Template

Introduction This method can be used to create a read-only spreadsheet template, that you can 
save as a different name and then modify to suit your needs.

If you are using similar samples and run conditions, this method allows you to type 
less each time you want to create a new plate record.

There are two parts to the procedure:

� Creating the template

� Modifying the template

Creating the
Template

Modifying the
Template

To create a custom spreadsheet template:

Step Action

1 Use the directions starting on page 4-19 to create a plate file (.plt file) that contains 
the basic information that you need for a plate record.

2 Open the .plt file in a spreadsheet program.

3 Save the spreadsheet as a read-only file to ensure that it does not get overridden.

To modify or create a plate record from a custom spreadsheet template:

Step Action

1 Open the spreadsheet that you just created to use as a template.

2 Save the spreadsheet under a different name, making sure that it is not read-only 
as above.

3 Edit the plate and sample data in the spreadsheet according to the specific plate 
and samples you are using.

4 Save the spreadsheet as a tab-delimited text file, giving it the .plt extension.

5 If needed, repeat steps 1 to 4 to create other tab-delimited text files.

6 Follow the directions starting on page 4-25 for importing a tab-delimited text file to 
create a plate record.
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Creating a Plate File from an Edited Plate Record

Introduction To save time when preparing plate records, you can save the data entered into the 
plate editor table as a tab-delimited text file. After changing the plate name, the file can 
be re-imported. Alternatively, it can be saved as a read-only file and used as a 
template.

Creating a Plate File
from an Edited Plate

Record

To create a plate file from an edited plate record:

Step Action

1 Open the Plate View page of the 3100 or 3100-Avant Data Collection software. 

2 a. In one of the plate record tables, double-click the plate record that you want to 
edit.

b. Edit the plate record as required.

3 From the File menu, select Export. 

This opens a browser dialog box.

4 Navigate to the folder in which you want to save the file. You may want to use the 
plate import files folder in the following directory:

D:\AppliedBio\Support Files\Data Collection Support Files\Plate Import Files

Note You cannot see Network Neighborhood directories from this browser dialog 
box.

5 a. In the File name dialog box, type a name for the file and add the extension .plt.

b. Click Save. 

This saves the file as a tab-delimited text file to the specified directory.

6 If you want to use this file as a template, give the file a read-only status:

a. Right-click the Start icon on the Windows NT taskbar, and from the pop-up menu 
select Explore. This opens Windows NT Explorer.

b. Navigate to the file that you just created.

c. Right-click the file and from the pop-up menu select Properties.

d. From the Attributes group box, select Read-only.

e. Click OK.

7 Follow the directions starting on page 4-25 for importing a tab-delimited text file to 
create a plate record.
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Importing Tab-Delimited Text Files and Linking Plate Records

Introduction To create and link a plate record by importing a plate file into the instrument database 
you must:

� Import the data 

� Place the plates

� Link the plates

In general, the steps for importing, placing, and linking are summarized in the diagram 
below.

Create .plt files

Place plates
(if not done yet)

Link one plate/
plate record

Import one .plt file to
create one plate record

Simultaneously import
multiple .plt files to
create multiple plate
records

Repeat

Repeat

Place plates
(now or later)

Sequentially import and link
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Sequentially
Importing and

Linking a Plate
Record

You can sequentially import a tab-delimited text file to create a plate record and then 
link it to its plate. It takes longer to perform these steps separately for a single plate 
record; however, you can import many tab-delimited text files at once. 

To import one or more tab-delimited text files to create plate records: 

Step Action

1 In the Plate View page of the 3100 and 3100-Avant Data Collection software, click 
Import. 

This opens an untitled browser dialog box.

2 Navigate to the directory location of the plate file(s) (.plt) that you want to import 
and link.

3 Click OK. 

This imports the .plt file(s) and creates one or more plate records.

Note If there is missing information in the file, you may be warned by an 
information box. This may happen, for example, if you make a typing error or list a 
module that no longer exists. Depending on the problem, the warning may 
accompany rejection of the entire plate record. However, in some circumstances, 
the data will be imported despite a warning. When this happens, the purpose of the 
warning is to prompt you to examine and correct the data in the plate editor. 

4 Review the plate records in the plate editor.

5 Link the plate record to the plate. 

If you want to create... Then...

a single plate record Select the .plt file. 

more than one plate record a. Click the Up One Level button.

b. Select a folder of .plt files.

All .plt files are imported and appear in the 
pending plate records table ready to be linked.
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Deleting Plate Records and Run Data

Introduction Delete the plate records and run data when the used space on drive E is more than 
8 GB. 

There are two ways to delete the processed frame data that is associated with plate 
records. You can:

� Use the Cleanup Database utility (CleanUpDB.bat)

� Delete individual plate records

Recommended
Procedure

The Cleanup Database utility is the recommended way to delete plate records 
because:

� It is much faster to delete the processed frame data than to delete individual plate 
records.

� It prevents problems that result from incomplete deletion of data.

Reference to the
Cleanup Database

Utility

The Cleanup Database utility deletes all run data and plate records from the 
database. Before running the utility, be sure that all runs have been extracted from the 
database.

To delete plate records and run data from the instrument database using the Cleanup 
Database utility, see “Deleting Processed Frame Data: Cleanup Database Utility” on 
page 5-4.

When to Delete
Individual Plate

Records

Use this method if you want to delete only:

� Plate records that have no associated run data

� Certain plate records

When a plate record is deleted, the run data associated with samples in the plate is 
also deleted from the instrument database.

Note A new run cannot be started while a plate record is being deleted.

IMPORTANT You cannot delete a linked plate record, but plate records for unlinked, partially 
processed plates can be deleted. If the processed runs from unlinked partially processed plates 
have not yet been extracted, the run information will be deleted from the database. The pending 
plate record table is where unlinked partially processed plates are listed. 
Make sure that processed runs have been extracted by looking in the 
D:Appliedbio\3100\DataExtractor or D:Appliedbio\3100-Avant\DataExtractor and verifying all 
sample files for all runs performed are there.

CAUTION!
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Deleting Individual
Plate Records

To delete individual plate records:

Step Action

1 Click the Plate View tab in the 3100 and 3100-Avant Data Collection software. 

This opens the Plate Setup page.

2 In either the Pending or Processed Plate Record table, select the row that names 
the plate record you want to delete.

Note You can select more than one row at a time by pressing CTRL while selecting 
additional rows.

3 Click Delete.

Note If you have created, linked or edited plates after runs have been deleted, the 
deleted runs will be rescheduled.
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System Management and 
Networking 5

In This Chapter The following topics are covered in this chapter:

Topic See Page

Storing Run Data 5-2

Recovering Data: Extractor Utility 5-2

Deleting Processed Frame Data: Cleanup Database Utility 5-4

Importing: Method Import Utility 5-6

Removing Run Modules from the Instrument Database: Remove Run Modules 
Utility

5-7

Reinitializing the Instrument Database: Initialize Database Utility 5-8

Networking Options 5-9

Networking the Computer Workstation 5-11

Requirements for a Networked Computer 5-12

5
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Storing Run Data

Types of Run Data
Storage

Run data is stored in different forms, depending on the configurations selected in the 
Preferences and Auto Extractor dialog boxes:

Recovering Data: Extractor Utility

Function The auto extractor should automatically extract data from stopped runs. If 
autoextraction fails, use the Extractor utility as described below.

Extractor Utility’s re-extracted data will go to either:

� D:\Appliedbio\3100\Data Extractor\Extracted Runs 

� D:\Appliedbio\3100-Avant\Data Extractor\Extracted Runs

Note Re-extracted data can also be stored to Sequence Collector if set up.

Note View the xx_analysis.log or the xx_extraction.log file to see if the extraction completed 
successfully. 

Selecting and
Queuing Runs for

Extraction

You can queue runs for extraction. This is especially useful for extracting failed runs or 
batches of runs.

Data Storage Type Where Stored
Approximate Data Storage 
Space

Processed frame data In the instrument database E drive of the local computer 
workstation

100 MB for a 2.5-h run

ABIF sample file On the local or networked hard drive D drive, at a 
directory location specified in the Extraction Directory 
dialog box of Auto Extractor

The default setting is to store ABIF sample files in the 
following directory:
D:\AppliedBio\3100\Data Extractor or
D:\AppliedBio\3100-Avant\Data Extractor

� 250 KB per sample file for a 
ABI PRISM® 3100 POP-4™ 

polymer sequencing analysis 
run

� 210 KB per sample file for a 
ABI PRISM® 3100 POP-6™ 
polymer fragment analysis 
run

� 300 KB per sample file for a 
ABI PRISM® 3100 POP-4™ 
polymer fragment analysis 
run

Sequence Collector 
data

Sequence Collector database on another networked 
computer

–

To select and queue runs for extraction: 

Step Action

1 Verify that the OrbixWeb™ Daemon and AEServer are running.

2 Quit the Data Collection software.

Note The Extractor utility and Data Collection cannot run simultaneously.
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Preferences You may set the same preferences as in the data collection software by going to 
Extract > Preferences in the Extractor Utility. 

3 a. Click the Start menu.

b. Point to Applied Biosystems > 3100 Utilities > Extractor Utility or 
Applied Biosystems > 3100-Avant Utilities > Extractor Utility

4 Select a run or runs to extract.

Note Do not select runs with Not extractable status.

5 Click Extract.

The data will be extracted to the location defined in your preferences or the default 
location.

For the 3100 system: 
D:\AppliedBio\3100\Data Extractor\Extracted Runs 

For the 3100-Avant system:
D:\AppliedBio\3100-Avant\Data Extractor\Extracted Runs

To select and queue runs for extraction: (continued)

Step Action
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Deleting Processed Frame Data: Cleanup Database Utility

Function The Cleanup Database utility deletes the processed frame data and all associated run 
information stored in the 3100 or 3100-Avant Data Collection software database. This 
utility is used to make room for new run data.

The Cleanup Database utility deletes all of the:

� Processed frame data

� Plate records and run data

This utility does not delete the:

� Electrophoresis modules automatically imported from the supplied method files

� Run modules that you have created

� Spatial and spectral calibration data obtained from the last calibration runs 
performed

� Instrument-specific information such as the instrument name, serial number, user 
names, dye set information, etc.

Note The utility defragments the E partition.

File Name and
Directory

The Cleanup Database utility is named CleanUpDB.bat and is located in either 
following directory:

� D:\AppliedBio\3100\Bin 

� D:\AppliedBio\3100-Avant\Bin

When to Perform You will be prompted by the software to run the Cleanup Database utility when the 
database is approximately 75% full.

IMPORTANT Never run the Cleanup Database utility more than once a day because 
previously extracted sample files may be overwritten. This can happen due to the format used 
for a run name.

Deleting Processed
Frame Data

The Cleanup Database utility deletes all run data and plate records in the 
database. Before running the utility, be sure that all runs have been extracted from the 
database.

To delete processed frame data using the Cleanup Database utility: 

Step Action

1 Ensure that OrbixWeb Daemon and AE server are running.

2 Quit the 3100 or 3100-Avant Data Collection software.

3 Using Windows NT Explorer, navigate to the following directory: 
D:\AppliedBio\3100\Bin or D:\AppliedBio\3100-Avant\Bin

CAUTION!
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Note There is no need to re-import the spatial, spectral, and run calibration methods or the 
calibration data obtained from the last calibration runs.

Deleting the plate record for a plate of samples is another way to delete processed 
frame data stored in the instrument database.

Directions for deleting individual plate records start on page 4-28.

4 Locate and double-click CleanUpDB.bat. 

This runs the Cleanup Database utility, which takes a few seconds to complete.

5 Shut down and then relaunch OrbixWeb Daemon.

If you do not perform this step, any new run data will not be saved 
to the database.

To delete processed frame data using the Cleanup Database utility: (continued)

Step Action

CAUTION!
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Importing: Method Import Utility

Function Method files contain the parameters that define the run conditions (along with the 
SCPI commands that direct the operation of the instrument).

New methods provided by Applied Biosystems must be imported into the instrument 
database before they can be used. The Method Import Utility imports these methods.

Importing a Method An application replaces editing and running the MethodImportUtility.bat batch file.

To import a method: 

Step Action

1 Ensure OrbixWeb Daemon is running.

2 Quit the data collection software.

Note The method import utility and data collection software cannot run 
simultaneously.

3 Navigate to the following location: 

D:\AppliedBio\3100\Bin or D:\AppliedBio\3100-Avant\Bin

4 Open the MethodImportUtility.bat file. 

5 Click Browse and locate the method file you want to import into the database.

Note All method files have an .mtd extension.

6 Click Import.

7 View the results in the Status section.
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Removing Run Modules from the Instrument Database: 
Remove Run Modules Utility

Function The Remove Run Modules utility removes all modules and associated information 
from the instrument database. This utility is used to quickly delete all old modules 
before you import new ones.

File Name and
Directory

The Remove Run Modules utility is named RemoveRunModules.bat and is located in 
the following directory:

D:\AppliedBio\3100\Bin or D:\AppliedBio\3100-Avant\Bin

Removing Run
Modules

To remove run modules using the utility:

Step Action

1 Ensure OrbixWeb Daemon and AE are running.

2 Quit the 3100 or 3100-Avant Data Collection software.

3 Using Windows NT Explorer, navigate to the following directory: 

D:\AppliedBio\3100\Bin or D:\AppliedBio\3100-Avant\Bin

4 Locate and double-click RemoveRunModules.bat.
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Reinitializing the Instrument Database: Initialize Database Utility

Function The Initialize Database utility completely erases and reinitializes the instrument 
database.

File Name and
Directory

The Initialize Database utility is named InitDB.bat and is located in the following 
directory:

D:\AppliedBio\3100\Bin or D:\AppliedBio\3100-Avant\Bin

Erasing and
Reinitializing the

Instrument
Database

IMPORTANT Do not run this utility unless instructed to do so by a Applied Biosystems 
representative. 

The Initialize Database utility completely erases the instrument database. All 
raw data, plate records, customized run modules, spatial and spectral calibrations, and 
instrument-specific information such as polymer and capillary array information will be deleted.

To remove, erase, and reinitialize the instrument database using the utility:

Step Action

1 Ensure OrbixWeb Daemon and AE are running.

2 Quit the 3100 or 3100-Avant Data Collection software.

3 Using Windows NT Explorer, navigate to the following directory:

D:\AppliedBio\3100\Bin or D:\AppliedBio\3100-Avant\Bin

4 Locate and double-click InitDB.bat.

5 Locate and double-click CreateIndex.bat.

6 Restart the computer.

CAUTION!
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Networking Options

Introduction You have the option of using the ABI PRISM® 3100 or 3100-Avant Genetic Analyzer as 
a stand-alone system. However, you will achieve optimal performance by integrating 
the 3100 or 3100-Avant Genetic Analyzer into your existing laboratory data flow 
system. The 3100 and 3100-Avant systems have flexible import and export 
capabilities that can be tailored to meet your needs. Other computers can, for 
example, be used for preparing plate records, providing more comprehensive 
analysis, and storing data.

The networking options are configured in the 3100 and 3100-Avant Data Collection 
software.

Overview Diagram The diagram below summarizes the relationships among the different elements of the 
software and the options for networking with external computers.

External Computers

3100 or 3100-Avant  
       Instrument

3100 or 3100-Avant  
NT WorkstationExternal computer with sample

records in a spreadsheet

Detector

External computer with:
• GeneScan Analysis software
• DNA Sequencing Analysis software

External computer with customized
software prepared with ABIF
Sample File Toolkit

Sequence  
Collector
database

Instrument
database

LIMS database

3100  or 3100-Avant  
Data Collection

software

GeneScan Analysis
software

DNA Sequencing Analysis
software

ABIF sample files

Import
data

to create
plate

records

Export
analyzed or
unanalyzed

data

Export unanalyzed
or analyzed data
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Using an Additional
Networked
Computer

Using an additional networked computer makes more efficient use of the 3100 and 
3100-Avant Genetic Analyzer. While the instrument is performing a run, you cannot 
create plate records, review data from past runs, or reanalyze data. By using another 
computer to perform these functions, you can perform more runs in a day.

The networked computer can run with a Microsoft® Windows NT® or Macintosh® 
operating system; however, if Macintosh versions of analysis applications are used, 
you can only view and edit the data. To reanalyze the data, you must use the Windows 
NT versions of analysis applications.

LIMS Database
Option

An external LIMS database can be used to assemble all of the data needed to create 
plate records. Once a LIMS database has been set up correctly and the data has 
been entered into the LIMS database, the creation of plate records in the LIMS 
database becomes automatic. Those plate records can then be exported from LIMS 
and imported into the 3100 or 3100-Avant Data Collection software.

Sequence Collector
Option

With the Sequence Collector database system, data is collected on the computer 
workstation and written to a Sequence Collector database on a networked server 
using Auto Extractor. The data can later be viewed and reanalyzed using DNA 
Sequencing Analysis software or GeneScan Analysis software. These programs can 
either be on the computer workstation, which is used to collect the data, or on a 
different computer that has access to the Sequence Collector database. The data can 
also be viewed and edited (but not analyzed) using DNA Sequencing Analysis 
software or GeneScan Analysis software on a Macintosh computer with access to the 
Sequence Collector database.

Stand-Alone Option With the stand-alone option, all operations, including the creation of plate records, 
collection of data, and review of data with GeneScan Analysis software or DNA 
Sequencing Analysis software, are carried out on the computer workstation.
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Networking the Computer Workstation

Introduction The 3100 and 3100-Avant Genetic Analyzer fully support connections to local area 
networks (LANS). Your network system must be planned and set up by a systems 
administrator who is familiar with the Windows NT operating system.

If you plan to add the computer workstation to a LAN, you should be aware of the 
following:

� The person logged in as 3100User or 3100-AvantUser must have system 
administration rights on the computer workstation.

� The computer workstation has two network interface cards.

Administrator
Privileges

For installation and upgrades to the software, the person logged in as 3100User or 
3100-AvantUser must be a member of the Administrators group.

Network Interface
Cards

The computer workstation has two network interface cards. These cards are:

� On the motherboard, which is connected to the instrument

� Installed in an expansion slot in the system unit, which can be used to connect to 
the network. (This card requires that drivers be installed.)

IMPORTANT Use only the network interface card in the expansion slot to connect to the LAN. 
The network interface card on the motherboard is reserved for the Ethernet connection to the 
instrument.

IP Address Your network system administrator must provide you with an IP address for networking 
to the LAN. This is not the same as the Internet Protocol (IP) address already being 
used to connect the computer workstation to the instrument.

IMPORTANT Do not modify the given IP address.

Windows NT User
Name

IMPORTANT Do not change the default Windows NT logon user name from “3100User” or 
“3100-AvantUser.” This will break the connection with the 3100 or 3100-Avant Data Collection 
software and make the software inoperable.

To view the Windows NT logon user name:

Step Action

1 Press Ctrl+Alt+Delete. 

This opens the Windows NT Security dialog box. The user name is displayed in the 
Logon Information group box in the following message:

Name is logged on as name-instrument serial number
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Viewing the
Computer Name

The computer name is set during installation using the 3100 or 3100-Avant instrument 
serial number.

Requirements for a Networked Computer

Minimum
Requirements

The minimum requirements for running either DNA Sequencing Analysis or 
GeneScan Analysis software are:

� Intel Pentium processor, 400 MHz or faster

� Microsoft® Windows NT® 4.0 operating system with Service Pack 5

� 256-color display adapter card

� CD-ROM drive

Hard Disk Space Ensure that the networked computer has sufficient hard disk space to hold as many 
sample files as desired. One analyzed sample file is about 250 KB.

To see the computer name and network domain:

Step Action

1 Select Start > Settings > Control Panel. 

2 In the Control Panel window, double-click Network. 

This opens the Network property sheet. The Identification tabbed page displays the 
computer name and domain.

For... RAM (MB)  Hard Disk Space (MB) 

Extraction only 64 80 

Extraction and analysis 256 120
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Troubleshooting 6

In This Chapter The following troubleshooting topics are covered in this chapter:

Topic See Page

Instrument Startup 6-2

Spatial Calibration 6-3

Spectral Calibration 6-4

Run Performance 6-5

Software 6-11

6
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Instrument Startup

Troubleshooting Instrument Startup 

Observation Possible Cause Recommended Action

No communication between the 
instrument and the computer. The 
event viewer is blank.

Incorrect Ethernet configuration. Check the configuration of the IP 
address. 

a. Select Start > Programs > 
Command Prompt.

b. At the C:\ prompt, type
IPconfig /all.

c. Press Enter. The command prompt 
window displays information on 
the network.

d. Ensure the IP address for Ethernet 
adapter 1 is set for the machine 
(i.e., the motherboard Ethernet 
connection). The correct IP 
address is: 192.168.0.1

Note The local IT group should use 
Adapter 2 for networking.

Red light is blinking. Incorrect start up procedure. Start up in the following sequence:

a. Log out of the computer.

b. Turn off the instrument.

c. Boot up the computer.

d. After the computer has booted 
completely, turn the instrument on. 
Wait for the green status light to 
come on.

e. Launch the Data Collection 
software.

Data Collection software will not 
launch.

Did not launch OrbixWeb™ Daemon 
first.

Relaunch application following 
OrbixWeb Daemon.

Computer screen is frozen. Communication error. This may be 
due to leaving the user interface in 
the Capillary View or Array View 
window.

There will be no loss of data. 
However, if the instrument is in the 
middle of a run, wait for the run to 
stop. Then, exit the Data Collection 
software and restart as described 
above.

Autosampler does not move to the 
forward position.

Possible communication error. Restart the system, and then press 
the Tray button.

Oven or instrument door is not 
closed.

a. Close and lock the oven door.

b. Close the instrument doors.

c. Press the Tray button.

Instrument does not respond to 
commands immediately after closing 
the doors.

Autosampler reinitializes its location. Wait for the autosampler to home 
before continuing.
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Spatial Calibration

Auto analysis did not occur. The AE server was not launched first. Launch AE server.

Auto analysis was not set in 
Preferences.

Select Auto analysis.

Troubleshooting Instrument Startup (continued)

Observation Possible Cause Recommended Action

Troubleshooting Spatial Calibrations

Observation Possible Cause Recommended Action

Unusual peaks or a flat line for the 
spatial calibration.

The instrument may need more time 
to reach stability. An unstable 
instrument can cause a flat line with 
no peaks in the spatial view.

Check or repeat spatial calibration.

Improper installation of the detection 
window.

Reinstall the detection window and 
make sure it fits in the proper position.

Broken capillary resulting in a bad 
polymer fill.

Check for a broken capillary, 
particularly in the detection window 
area. If necessary, replace the 
capillary array using the Install Array 
Wizard.

Dirty detection window. Place a drop of methanol onto the 
detection window, and dry with 
compressed air. Use only light air 
force. 

CHEMICAL HAZARD. 
Methanol is a flammable liquid and 
vapor. Exposure may cause eye, skin, 
and respiratory tract irritation, and 
central nervous system depression 
and blindness. Read the MSDS, and 
follow the handling instructions. Wear 
appropriate protective eyewear, 
clothing, and gloves.

Persistently bad spatial calibration 
results.

Bad capillary array. Replace the capillary array, and then 
repeat the calibration. Call Technical 
Support if the results do not improve.
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Spectral Calibration

Troubleshooting Spectral Calibrations

Observation Possible Cause Recommended Action

No signal. Incorrect preparation of sample. Replace samples with fresh samples 
prepared with fresh Hi-Di™ 
formamide.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and 
respiratory tract irritation. It is a 
possible reproductive and birth defect 
hazard. Read the MSDS, and follow 
the handling instructions. Wear 
appropriate protective eyewear, 
clothing, and gloves.

Air bubbles in sample tray. Centrifuge samples to remove air 
bubbles.

Autosampler not correctly aligned. 
The capillary tips may be hitting the 
bottom of the wells, or they may not 
be touching the samples.

Check the autosampler calibration. If 
necessary, recalibrate the 
autosampler using the Autosampler 
Calibration Wizard.

If the spectral calibration fails, or if a 
message displays “No candidate 
spectral files found.”

Clogged capillary. Refill the capillaries using manual 
control. Look for clogged capillaries 
during capillary fill on the cathode 
side.

Incorrect parameter files and/or run 
modules selected.

Correct the files and rerun the 
calibration.

Insufficient filling of array. Check for broken capillaries and refill 
the capillary array.

Expired matrix standards. Check the expiration date and storage 
conditions of the matrix standards. If 
necessary, replace with a fresh lot.

Data Error - One or more peaks fall 
below the minimum required 
amplitude of 750.

One or more peaks fall below the 
minimum required amplitude of 750.

Rerun the spectral standards, and if 
necessary, increase the amount of 
spectral standard added.

Spikes in the data. Expired polymer. Replace the polymer with a fresh lot 
using the Change Polymer Wizard.

CHEMICAL HAZARD. 
POP-4 polymer and POP-6 cause eye, 
skin, and respiratory tract irritation. 
Read the MSDS, and follow the 
handling instructions. Wear 
appropriate protective eyewear, 
clothing, and gloves.

Air bubbles, especially in the polymer 
block tubing assembly.

Refill the capillaries using manual 
control.

Possible contaminant or crystal 
deposits in the polymer.

Properly bring the polymer to room 
temperature; do not heat to thaw 
rapidly. Swirl to dissolve any solids.

Replace the polymer if it has expired.

WARNING!
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Run Performance

Troubleshooting Run Performance 

Observation Possible Cause Recommended Action

No data in all capillaries. � Bubbles in the system.

� No sample injection

Visually inspect the polymer block and the 
syringes for bubbles.

Remove any bubbles using the Change Polymer 
Wizard. 

If bubbles still persist, perform the following:

a. Remove the capillary array.

b. Clean out the polymer block and syringes. 

c. Replace polymer with fresh polymer. Make 
sure to draw the polymer into the syringe very 
slowly.

CHEMICAL HAZARD. POP-4 
polymer and POP-6 causes eye, skin, and 
respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Possible contaminant in the polymer 
path.

Wash the polymer block with hot water. Pay 
attention to the upper polymer block, the ferrule, 
the ferrule screw, and the peek tubing. Dry the 
parts with compressed air before replacing them 
onto the instrument. 

IMPORTANT Do not wash syringes in hot water 
because the Teflon plungers will get damaged.

Possible contaminant or crystal 
deposits in the polymer.

Bring the polymer to room temperature, swirl to 
dissolve any deposits.

Replace the polymer if it has expired.

CHEMICAL HAZARD. POP-4 
polymer and POP-6 cause eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

WARNING!

WARNING!
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No signal. Autosampler calibration is not 
optimal.

Check the injection with 20-µL samples. If the 
injection is OK, recalibrate the autosampler using 
the Autosampler Calibration Wizard. Pay 
particular attention to the Z-axis.

If the injection is not OK, perform the procedures 
below.

Dead space at bottom of sample 
tube.

Centrifuge the sample tubes.

Bent capillary array. Replace the capillary array and recalibrate the 
autosampler using the Calibrate Autosampler 
Wizard.

Failed reaction. Repeat reaction.

Cracked or broken capillary Visually inspect the capillary array, including the 
detector window area for signs of breakage.

Signal too high. Sample concentration is too high. Dilute the sample.

Decrease the injection time.

Too much DNA added to the reaction, 
resulting in uneven signal distribution.

Optimize chemistry.

Low signal strength. Poor quality formamide. Use a fresh lot of Hi-Di formamide.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Pipetting error; not enough sample. Increase the amount of DNA added. 

Recalibrate the pipets.

Sample has high salt concentration. Dilute in high-quality water.

Desalt using a column purification method.

Insufficient mixing. Vortex the sample thoroughly, and then 
centrifuge the tube to condense the sample to 
the bottom of the tube.

Autosampler out of calibration. Check the injection with 20-µL samples. If the 
injection is OK, recalibrate the autosampler using 
the Autosampler Calibration Wizard. Pay 
particular attention to the Z-axis.

Weak amplification of DNA. Reamplify the DNA.

Check DNA quality.

Troubleshooting Run Performance (continued)

Observation Possible Cause Recommended Action
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Elevated baseline. Possible contaminant in the polymer 
path.

Wash the polymer block with hot water. Pay 
attention to the upper polymer block, the ferrule, 
the ferrule screw, and the peek tubing. Dry the 
parts with compressed air before replacing them 
onto the instrument. 

IMPORTANT Do not wash syringes in hot water 
because the Teflon plungers will get damaged.

Possible contaminant or crystal 
deposits in the polymer.

Bring the polymer to room temperature, swirl to 
dissolve any deposits.

Replace the polymer if it has expired.

CHEMICAL HAZARD. POP-4 
polymer and POP-6 cause eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Poor spectral calibration. Perform new spectral calibration.

Detection cell is dirty. Place a drop of methanol onto the detection 
window and dry with compressed air. Use only 
light air force. 

Loss of resolution. Too much sample injected. Dilute the sample and re-inject.

Poor quality water. Use high-quality, ultra-pure water.

Poor quality or dilute running buffer. Prepare fresh running buffer from 10X 3100 
buffer with EDTA.

CHEMICAL HAZARD. 10X Genetic 
Analyzer Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Poor quality or breakdown of polymer. Use a fresh lot of polymer.

Capillary array used for more than 
100 injections.

Replace with new capillary array.

Degraded formamide. Prepare fresh Hi-Di formamide and re-prepare 
samples.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

High salt concentration in samples. Use a recommended protocol for salt removal. 
Dilute salts with water.

Poor resolution in some 
capillaries.

Insufficient filling of capillary array. Refill the capillary array and look for cracked or 
broken capillaries. If problem persists contact 
Technical Support.

Re-inject the same samples.

Poor quality samples. Check the sample preparation.

Troubleshooting Run Performance (continued)

Observation Possible Cause Recommended Action

WARNING!
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No current. Poor quality water. Use only high-quality ultra-pure water.

Water placed in buffer reservoir 
position 1.

Replace with fresh 3100 1X running buffer.

Not enough buffer in anode reservoir. Add buffer up to the fill line. 

Buffer too dilute. Prepare 1X running buffer.

Add 3 mL 10X Genetic Analyzer Buffer with 
EDTA to 27 mL deionized water.

CHEMICAL HAZARD. 10X Genetic 
Analyzer Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Bubble(s) present in the polymer 
block and/or the capillary and/or 
PEEK tubing.

Pause run and inspect for the instrument for 
bubbles. They may be hidden in the PEEK 
tubing.

Remove any bubbles according to the remove 
bubble procedure in the Replace Polymer 
Wizard.

Elevated current. Decomposed polymer. Open fresh lot of polymer and store at 4 °C.

Incorrect buffer dilution. Prepare 1X running buffer.

Add 3 mL 10X Genetic Analyzer Buffer with 
EDTA to 27 mL deionized water.

CHEMICAL HAZARD. 10X Genetic 
Analyzer Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Arcing in the gel block. Check for moisture in and around the septa, the 
reservoirs, the oven, and the autosampler.

Troubleshooting Run Performance (continued)

Observation Possible Cause Recommended Action
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Fluctuating current. Bubble in polymer block. Pause the run, check the polymer path for 
bubbles, and remove them if present.

A slow leak may be present in the 
system.

Check polymer blocks and syringes for leaks. 
Tighten all fittings.

Incorrect buffer concentration. Prepare 1X running buffer.

Add 3 mL 10X Genetic Analyzer Buffer with 
EDTA to 27 mL deionized water.

CHEMICAL HAZARD. 10X Genetic 
Analyzer Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Not enough buffer in anode reservoir. Add buffer up to the fill line. 

Clogged capillary. Refill capillary array and check for clog.

Arcing Check for moisture in and around the septa, the 
reservoirs, the oven, and the autosampler.

Poor performance of 
capillary array used for 
fewer than 100 runs.

Poor quality samples, possible 
cleanup problems.

Desalt samples using a recommended 
purification protocol.

Poor quality formamide. Prepare fresh Hi-Di formamide and re-prepare 
samples.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Incorrect buffer. Use 10X Genetic Analyzer Buffer with EDTA to 
prepare 1X running buffer.

CHEMICAL HAZARD. 10X Genetic 
Analyzer Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Migration time becomes 
progressively slower.

Leak in system. Tighten all ferrules, screws, and check valves. 
Replace any faulty parts.

Improper filling of polymer block. Check polymer pump force. If the force needs to 
be adjusted, call a service representative.

Expired polymer. Check expiration of polymer. If necessary, 
change the lot.

Migration time becomes 
progressively faster.

Water in syringe resulting in diluted 
polymer.

Clean the syringe and dry it with compressed air.

Troubleshooting Run Performance (continued)

Observation Possible Cause Recommended Action
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Extra peaks in the 
electropherogram.

Data off scale. Dilute the sample and re-inject the sample.

Possible contaminant in sample. Re-amplify the DNA.

Sample renaturation. Heat-denature the sample in good-quality 
formamide and immediately place on ice.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Peaks exhibit a shoulder 
effect in GeneScan 
applications.

Sample renaturation. Heat-denature the sample in good-quality 
formamide and immediately place on ice.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Purging of polymer from 
the polymer reserve 
syringe.

Arcing in the anode gel block. Replace the lower polymer block.

Bubbles in syringes. Remove bubbles.

Leaking polymer at the top 
of either syringe.

Insufficient seal around the Teflon tip 
of the plunger.

Make sure to wet the Teflon before filling the 
syringe with polymer. If the leaking persists, 
replace the syringe.

Note Do not mix and match barrels and 
plungers

Leaking polymer at the 
bottom of the 
polymer-reserve syringe.

Improper tightening of the array 
ferrule knob to the syringe or/and to 
the polymer block.

Ensure the array ferrule knob is tightened. 

Error message, “Leak 
detected” appears. The 
run aborts.

Air bubbles in the polymer path. Check for bubbles and remove if present. Then, 
look for leaks. 

Buffer jar fills very quickly 
with polymer.

Air bubbles in the polymer path. Check for bubbles and remove if present. 
Bubbles can cause polymer to fill the jar.

Detection window pops 
out while replacing the 
capillary array. Replacing 
the window in the correct 
orientation is difficult.

Tightening of the array ferrule knob at 
the gel block causes high tension.

Loosen the array ferrule knob to allow the secure 
placement of the window. Retighten and close 
the detection door.

Detection window stuck. It 
is difficult to remove when 
changing the capillary 
array.

To loosen the detection window:

a. Undo the array ferrule knob and pull the 
polymer block towards you to first notch.

b. Remove the capillary comb from the holder in 
oven.

c. Hold both sides of the capillary array around 
the detection window area, and apply gentle 
pressure equally on both sides.

d. Release.

Troubleshooting Run Performance (continued)

Observation Possible Cause Recommended Action
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Software

Troubleshooting Software 

Observation Possible Cause Recommended Action

An imported run module file does not 
import.

There is no error message.

The file name is longer than 32 
characters.

Rename the run module file using 
less than 32 characters.
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Technical Support A

Services and Support

Applied Biosystems
Web Site

A services and support page is available on the Applied Biosystems Web site. To 
access this, go to:

http://www.appliedbiosystems.com

and click the link for services and support.

At the services and support page, you can:

� Search through frequently asked questions (FAQs)

� Submit a question directly to Technical Support

� Order Applied Biosystems user documents, MSDSs, certificates of analysis, and 
other related documents

� Download PDF documents

� Obtain information about customer training

� Download software updates and patches

In addition, the services and support page provides worldwide telephone and fax 
numbers to contact Applied Biosystems Technical Support and Sales facilities.

A
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Part Numbers B

Applied Biosystems Part Numbers

Introduction Part numbers for many consumables are given in this appendix. Refer to these part 
numbers when ordering from Applied Biosystems.

More information about Applied Biosystems kits and consumables is available from 
your sales representative or on the web at http://www.appliedbiosystems.com

Instrument
Hardware

Plate Assembly Kits

Software Kits

Instrument
Consumables

Description Part Number

ABI PRISM® 3100 Genetic Analyzer with computer workstation 3100-01

ABI PRISM® 3100-Avant Genetic Analyzer with computer workstation 3100-AVANT

Printers (sold only with ABI PRISM instruments)

HP Deskjet 990CXI 4328881

Description Part Number

96-well plate kit 4316471

384-well plate kit 4316472

Description Part Number

ABI PRISM® 3100 GeneScan® Analysis Software Module Kit 4317379

ABI PRISM® 3100 DNA Sequencing Analysis Software Module Kit 4317380

Description Part Number

96-well plate septa 4315933

MicroAmp® Optical 96-well Reaction Plates N801-0560

384-well plate septa 4315934

MicroAmp® 384-well Reaction Plates 4305505

Reservoir septa 4315932

B
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DNA Sequencing
Reagents and
Consumables

GeneScan Reagents
and Consumables

Instrument Spare
Parts

Description Part Number

ABI PRISM® 3100 POP-6™ polymer 4316357

ABI PRISM® 3100 POP-4™ polymer 4316355

ABI PRISM® 3100 capillary array, 50-cm 4315930

ABI PRISM® 3100 capillary array, 36-cm 4315931

ABI PRISM® 3100 capillary array, 80-cm 4319899

ABI PRISM® 3100-Avant capillary array, 50-cm 4333466

ABI PRISM® 3100-Avant capillary array, 36-cm 4333464

ABI PRISM® 3100-Avant capillary array, 80-cm 4333465

Genetic Analyzer Buffer with EDTA (10X) 402824

Matrix Standard Set DS-01 (dROX, dTAMRA, dR6G, dR110) 4315974

ABI PRISM® BigDye® Terminator Sequencing Standards Kit 4304154

Hi-Di™ Formamide, 25-mL bottle 4311320

Description Part Number

ABI PRISM® 3100 POP-4™ polymer 4316355

ABI PRISM® 3100 capillary array, 36-cm 4315931

ABI PRISM® 3100 capillary array, 22-cm 4319898

ABI PRISM® 3100-Avant capillary array, 36-cm 4333464

ABI PRISM® 3100-Avant capillary array, 22-cm 4333463

Genetic Analyzer Buffer with EDTA (10X) 402824

Matrix Standard Set DS-02 (dR110, dR6G, dTAMRA™, dROX™, LIZ™) 4323014

Matrix Standard Set DS-30 (6FAM™, HEX, NED, ROX™) 4316100

Matrix Standard Set DS-32 (5-FAM, JOE, NED, ROX) 4323018

Matrix Standard Set DS-33 (6FAM, VIC, NED, PET™, LIZ™) 4323016

ABI PRISM® 3100 GeneScan™ Installation Standard DS-30 4316144

Hi-Di™ Formamide, 25-mL bottle 4311320

Description Part Number

96-well plate retainer 4317241

96-well plate base (AB) 4317237

384-well plate retainer 4317240

384-well plate base 4317236

Reservoirs (for buffer, water, and waste) 628-0163

Glass syringe, 5.0-mL polymer-reserve 628-3731

Glass syringe,  250-µL array-fill 4304470

Syringe O-rings 221102

Syringe ferrule 005401

Anode buffer reservoir jar 005402

Upper polymer block drip tray 628-3720
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Reference Materials

Lower polymer block drip tray 628-3088

Autosampler drip tray 628-3059

Polymer block tubing assembly 628-3732

Array calibration ruler 628-3214

Array comb holders 628-3403

Array ferrule sleeves 628-0165

Array ferrule knob 628-3730

Description Part Number

Description Part Number

ABI PRISM® 3100 Genetic Analyzer and ABI PRISM® 3100-Avant Genetic 
Analyzer User Reference Guide

4335393

ABI PRISM® 3100 Genetic Analyzer Sequencing Chemistry Guide v. 3.7 4315831

ABI PRISM® GeneScan® Analysis v. 3.7 NT User Guide 4308923

ABI PRISM® 3100 Genetic Analyzer User Guide 4334785

ABI PRISM® Sequencing Analysis Software v. 3.7 NT User Guide 4308924

ABI PRISM® 3100-Avant Genetic Analyzer User Guide 4333549

ABI Prism® 3100 Genetic Analyzer Operator Training CD 432559
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Index

Numerics
3100 and 3100-Avant software CDs 3-2

A
.ab1 files. See ABIF sample files
ABI Sample File Toolkit 3-5
ABIF sample files

access through developer’s toolkit 3-5
discussed 5-2

Adobe Acrobat Reader 3-6
AE server 3-5
analysis module

provided modules 4-5
analysis parameter files. See sequencing
analysis.log file 5-2
array. See capillary array
auto extractor 3-5
autosampler

controlling. See manual control commands
will not move forward 6-2

B
basecaller settings file, creating 3-24
BLOB 4-18

C
camera, CCD. See CCD camera
capillary array 2-14

filling. See manual control commands
poor performance 6-9

CCD camera 2-18
CD list, software 3-2
chemical hazard warning 1-4
chemistry

dye sets 2-11
overview 2-13
types supported 2-11

Cleanup Database utility 4-27, 5-4
colors, displayed dye. See displayed dye colors
commands, manual control 3-11
Computer 1-7
computer

checking logon user name 5-11
frozen 6-2
hard drive partitions 2-9
name, finding 5-12
network domain, finding 5-12
networked computer requirements 5-12
networking 5-9 to 5-12
requirements 2-9
system administration privileges 5-11

computer, safety 1-7
Control Panel window 5-12

current, troubleshooting 6-8
customer support. See technical support A-1

D
data

hiding for specific dyes 3-8
none in capillaries 6-5
recovering 5-2
storage 5-2

Data Collection software 3-3
will not launch 6-2

Data Delay Time run module parameter 3-17
data flow, overview 5-9
database

LIMS. See LIMS database
reinitializing 5-8
removing run modules using utility 5-7
Sequence Collector. See Sequence Collector database

debug.log 3-44
deleting

from plate import table 4-17
plate record 4-27
processed frame data from database 5-4

developer’s toolkit 3-5
directories, list 3-7
display colors, changing using HSV 3-9, 3-10
displayed dye colors 3-8 to 3-10
documents, list 1-3, B-3
dye colors

changing 3-8
changing the name or color intensity 3-8
See also displayed dye colors

dye sets 4-3
composition 2-11

E
Edit Dye Display Information dialog box 3-8
electrophoresis, discussed 2-15 to 2-16
elevated baseline 6-7
event viewer, blank 6-2
Excel. See Microsoft Excel
exporting run modules to file 3-19
extensions, filename 3-7
extracting data.See auto extractor
extracting to Sequence Collector 3-39
extraction.log file 5-2
Extractor Utility 5-2

F
FASTA format for .Seq files 3-27
file types 3-7

ABIF sample 5-2
analysis modules for fragment analysis (.gsp) 3-35



Index-2

basecaller settings (.bcp) 3-24
portable document format (.pdf) 3-6
run data 5-2
run module (.modexp) 3-18
sequencing analysis module (.saz) 3-27
size-standard (.szs) 3-32
tab-delimited text files, plate records 4-7 to 4-15

filename extensions 3-7
firmware 3-3
fluorescence detection, discussed 2-17
fragment analysis

analysis modules, creating 3-35 to 3-36
analysis modules, viewing 3-30
chemistry, types supported 2-11
polymer 2-12

G
GeneScan Analysis Software 3-6
.gsp files. See fragment analysis modules

H
hard drive 2-9
hardware overview 2-5 to 2-8
hazardous 1-4
Hi-Di formamide 2-13
HSV color system 3-10

I
importing

linking a plate record 4-26
plate records from a LIMS 4-16 to 4-18
run modules from file 3-20

Initialize Database utility 5-8
Injection Time run module parameter 3-17
Injection Voltage run module parameter 3-17
instrument

hardware 2-5 to 2-8
operation overview 2-3 to 2-4
status lights 2-6

instrument database 3-6
deleting from 5-4
plate import table 4-17
See also processed frame data

IP address
for networking to LAN 5-11

J
Java Runtime Environment 3-6

L
labels, instrument safety 1-6
LAN. See networking 5-9
laser

controlling. See manual control commands
discussed 2-17
hazard warning 2-17

"Leak detected" 6-10
LIMS database

importing plate records from 4-16 to 4-18
option 5-10

log file, analysis or extraction 5-2
log file, viewing for a run 3-44
logging on, checking user name 5-11
loss of resolution 6-7
low signal strength 6-6

M
Macintosh computer

using to view data 5-10
manual control commands 3-11
manual set B-3
Method Import Utility 5-6
Method Import utility

overview 3-5
Microsoft Excel

creating plate records 4-9, 4-19 to 4-21
middleware. See Orbix Desktop
migration time, too fast or too slow 6-9
mobility files

provided 4-4
.modexp (run module) files 3-18
MSDSs, ordering 1-6

N
networking 5-9 to 5-12
"No candidate spectral files found" 6-4

O
Oracle database

See also Sequence Collector database
See instrument database

Orbix Desktop 3-6
OrbixWeb software 3-6
oven, controlling. See manual control commands

P
partitions, computer hard drive 2-9
parts list B-1 to B-3
.pdf (portable document format) files 3-6
peaks, troubleshooting 6-10
Persistence Object Layer 3-6
plate file

creating 4-19 to 4-24
plate import table 4-17
plate record 3-39

deleting 4-27
deleting individual plate records 4-28
sequentially importing and linking 4-26

.plt (plate record) files 4-19 to 4-26
plate records

creating, overview of procedures 4-2
polymer

discussed 2-12
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POP. See polymer
Pre Run Time run module parameter 3-17
Pre Run Voltage run module parameter 3-17
processed frame data

deleting 5-4
size of 5-2

processed frame data, storing 5-2

R
red status light 6-2
reinitializing the database 5-8
RemoveRunModules.bat file 5-7
reset button, location 2-5
resolution, loss 6-7
RGB color system 3-9
run

elevated baseline 6-7
elevated current 6-8
fast migration time 6-9
fluctuating current 6-9
high signal 6-6
loss of resolution 6-7
low signal 6-6
no current 6-8
no signal 6-6
options 4-15
setup for multiple runs 4-15
slow migration time 6-9

run modules 3-13 to 3-20
creating 3-14
editing 3-15
editing or creating 3-14
exporting to file 3-19
importing and exporting 3-18
importing from file 3-20
parameters, described 3-17
provided 4-5
removing from the database 5-7
transferring between computers 3-18
viewing 3-13

Run Time run module parameter 3-17
Run Voltage run module parameter 3-17

S
safety 1-4
.seq (sequence text) files

option to write 3-27
Sequence Collector database

option discussed 5-10
working with 3-37 to 3-44

sequencing
analysis modules, creating 3-24 to 3-29
analysis modules, discussed 3-21 to 3-29
polymer 2-12

.saz (sequencing analysis module) file
creating 3-27
saving 3-28
viewing 3-21

Sequencing Analysis software 3-6
directory path for SeqA.exe 3-21

sequencing chemistry
types supported 2-11

Set Color command 3-8 to 3-10
signal too high 6-6
size-standard (.szs) files

creating 3-32 to 3-34
software

list of applications 3-2
overview of suite 3-3

spatial calibration
persistently bad results 6-3
unusual peaks 6-3

spectral calibration
no signal 6-4

spectral dispersion device, discussed 2-18
spectrograph 2-18
spreadsheet programs

creating plate records 4-9, 4-23
status lights 2-6
syringes

controlling. See manual control commands
leaking 6-10

system administration privileges
computer 5-11

system management options 5-9 to 5-10
.szs (size-standard) files

creating 3-32 to 3-34

T
technical support A-1
temperature, electrophoresis 2-15
templates, location 4-19
text files

See also .seq (sequence text) files

U
user name 5-11
utilities

Cleanup Database 5-4
Initialize Database 5-8
Method Import 5-6
Remove Run Modules 5-7

W
warning 1-4
warning, laser 2-17
waste, disposal 1-7
Windows NT Security dialog box 5-11
write .seq files option 3-27
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